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1 Hardware Setup

1.1 Getting to know your router

This product is designed for new flagship servManaged Service Home Router

Managed Service Home Router provides:
1. High performance:
* Dual-Core ARM up to 1.7G/1GB DDR RAM.
* Dual-Band wireless up to AC2550 (2.4G 200M * 4 + £83M * 4).
* Gigabyte 2x WAN/ 4x LAN Ethernet ports.
2. High security: Firewall/VPN supported.
3. Easy to setup: Friendly wizard, visual setup & nemance (Basic Mode),
complete functions (Advanced Mode).
4. Easy to maintain: Supports TR069, TR181.
5. USB-based services: File/media/printer sharing.
The router is an ideal choice for residential al@H® (Small Office/Home Office)

users who can enjoy a variety of wireless applicetiand services.

This chapter contains the following contents:
* Unpack Your Router
* Hardware Features

¢ Position Your Router



1.2 Unpack Router’s box

Open the box and remove the router, cables, atallatson guide.
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Wireless router Ethernet Cable Power Aglap
Figure 1. Check the package contents

The box contains the following items:
* Wireless router.
* AC power adapter (plug varies by region).
* Ethernet cable.

* Installation guide.

If any items are missing or damaged, please cogtaat dealer. Please keep original

packing materials in case you need to return tbdymt for repairing.



1.3 Hardware Features

Before setup please take a moment to become famiiih the label and front, side,

and back panels of your router. Pay particulangtia to the LED on the front panel.

1.3.1 Front Panel

The router front and side panels feature the stiafil3 and buttons as shown in the

following figure.

Figure 2. Router front view

Front panel LED status

* Off: Device off.

* Blue quick blinking (0.4 second intervals): Booting up

* Blue blinking 1 second intervals: Connecting to Internet
* Blue solid: Connected to Internet.

* Redblinking: Connectivity  issues (no Internet

5



connection).

Red andBlue alternate blinking: Updating firmware

(or any scenario where device must not be resbarted

Red solid: Critical issues (hardware or otherwise).
LED on front of device will dim to low (65%) whehédre is no settings activity
or connectivity issues for 120 hours.

If any settings are changed or connectivity issaesur LEDs will return to

normal (100%) brightness.

1.3.2 Rear Panel

There are slots and buttons shown in the folloviiggre.

Wireless
o

=.\{;'\\.r.7ff-1

\=J - —
Figure 3. Router rear panel

Reset Button Push the button and hold for over 15 seconds) thater will
restart automatically. During the process of reéstauter will restore to factory
default settings.

WPS Button: Push the button more than 1 second to activd® and 5G WPS.
ReferencaVPS Setupon page 15.

LAN Port: Connect network cables for LAN (local area netyaronnections,
e.g. network switch, hub, personal computer orrh@edevices.
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* WAN Port: Connect a network cable for WAN (Wide Area Netlwaronnection.
This connects the Ethernet and other access ligesmnedem.

e USB 3.0 Port Connect a USB Printer, U-Disk or USB drive. Fomfer and
folder sharing, referenc®erviceson page 19.

* Power Port(DC-IN): Use the bundled AC adapter to connect your rotges

power source.

1.4 Position Your Router

The router lets you access your network from viuanywhere within the operating
range of your wireless network. However, the wgsleommunicating distance varies
significantly due to placement of the router. Foample, the thickness and number of
walls the wireless signal passes through can lingitrange. For best results, router is
likely to be place like this:

* Near the center of the area where your computeto#rer devices operate, and
preferably within line of sight to your wirelesswiges.

e So it is accessible to an AC power outlet and rigtiernet cables for wired
computers.

* In an elevated location such as a shelf, keepiaghttmber of walls and ceilings
between the router and your other devices to anmuimi.

e Away from electrical devices that are potential reesa of interference.
Equipment that might cause interference includekngefans, home security
systems, microwaves, computers, the base of aeswrgthone, or a 2.4 GHz
cordless phone.

* Away from any large metal surfaces, such as a soktial door or aluminum
studs. Large expanses of other materials suchaas,ghsulated walls, fish tanks,

mirrors, brick, and concrete can also affect youreless signal.



2 Normal User Settings

The wireless router contains an intuitive graphics@r interface (GUI) based on web,

which allows administrator to easily configurefgatures through a web browser.

2.1 Login

1. Open a web browser, then key in the router's defal# address:

http://192.168.1.1 and clickEnter key in the keyboard;

2. On the login webpage, type in its default Usernasenin and Passwordidmin,

then clickLogin button.

Charter

Spectrum»

Username

Password

After administrator has logged in the router, sdrasic information on it will be

displayed by the browser.



Spectrum |

Firmware Version: 1.0.3

Basic  Advanced Wizard
Network View

Network View >

My Router > @ c-n@ ....... :{» —

Parental Control >

Internet Wireless Router Users
Services >
System >
Up Time: 0D 22H 20M 535
System Information FW Version 1.0.3
HW version V1.0 REV:2
Date: 2016-12-30 02:41:26
IP 10.8.4.218
WAN )
Connection Type: DHCP
IP (Subnet Mask): 192.168.1.1(255.255.255.0)
LAN
DHCP on
SSID: MySpectrumWiFIBD-2G
2.4GHz: Authentication Method: WPA2 Personal
Wireless WPA Pre-shared Key: WriWAo43eSYce

SSID: MySpectrumWiFIBC-5G
5GHz: Authentication Method: WPA2 Personal
'WPA Pre-shared Key: yYFNEZMTDHOm

Generic_UDISK
usB DISK1 Available Space 5.2G
Total Space: 7.16

On the right top side, there are two command bstiGhange PassworcandLogout.
It's highly recommended to click tHeogout button who locates on the right top side

when administrator intends to leave the webpage.

When Change Password buttonhas been clickedthe browser will navigate

administrator to corresponding webpage.



Basic Advanced  Wizard
System
Network View >
My Router > Change the Router Login Password

Parental Control

hd

Username admin
Services > New Password
System > Retype New Password D Show Password

Miscellaneous

Time Zone America/New York -

Auto Logout 0 Minutes (Disable: 0)

NTP Server ( Maximum:6 )

NTP Server Add/Delete
&3
us.pool.ntp.org =l
north-america.pool.ntp.org (]
time.nst.gov (-]
pool.ntp.org e

On this page, administrator should just type in m@gsword in New Password and

Retype New Password, then clidpply button.

2.2 Wizard Setup

The wizard can navigate administrator to configo@sic settings for wireless router,

which makes it become easy enough to set up therrou

Internet Setup

After administrator has clicked the/izard button, thelnternet Setup page will
come up.

Connection Type:

There are 5 kinds of connection tyd@HCP, PPPoE Static, PPTP, and L2TP.
Consult your ISP if you are unsure which kind of M/8onnection type to select.

1. DHCP: Enable router to obtain IP addresses automatichllis type is usually
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used by cable modem service providers.

Basic Advanced Wizard
Internet Setup

1| Internet Setup

2 | Network Setup Connection Type

3 | Config Overview ® DHCP

DHCP allows your PC to obtain an IP address automaticlly. This connection type is often used by cable modem
senvice providers.

O PPPoE

ADSL or other connections that require a usemame and password are known as PPPoE.

O static

Static IP allows your PC to use a fixed IP address provided by your ISP. This connection type is often used by
ADSL service providers.

O PPTP

ADSL or other connections that require a usemame, password and IP address are known as PPTP.

O L2TP

L2TP requires a username.password and |P address provided by your ISP.

DHCP Setting

WAN MAC
Host Name
[ ]use wanDNs
DNS 1
DNS 2
[ Nt

WAN MAC : MAC address of WAN port. Some ISPs monitor desidédAC address
who are connecting to their networks, and only ¢hdsvices with a valid MAC
address can be served. If router can't get acodssernet, administrator can do either
of the followings:

* Contact your ISP and request to update the MA@regs associated with your
ISP subscription.

* Clone or change the MAC address of the new detoomatch the MAC address

of the original device.

* Host Name This field allows administrator to provide a narfee router.

Usually it's named by ISP.
* DNS 1 & DNS 2:Either of them indicates the IP address of a DE&&.
e Click Next.

2. PPPOE: An Internet protocol provided by ISPs which requiseasername and
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password. If you have no idea of theername and password please contact

your ISP.

PPPoE Setting

Username

Password

Next

* Username This field is only available when you set the WANMnNnNnection
Type as PPPoE, PPTP or L2TP.

» Password This field is only available when you set WAN @ation Type
as PPPoE, PPTP or L2TP.

e Click Next.

Static: Makes the router use a fixed IP address provided/dur ISP. This

connection type is often used by ADSL service paexs.

Static IP

P

Subnet Mask
Gateway
DNS 1

DNS 2

WAN MAC | MAC Clone |

* IP: Assigned by your ISP.

e Subnet Mask Assigned by your ISP.

* Gateway. IP address of the gateway. Assigned by your ISP.

* DNS 1 &DNS 2 Either of them indicates the IP address of DNiSesethat
the router will communicate with.

 WAN MAC: MAC address is a unique identifier that identifigeur

computer or device. ISPs monitor the MAC addresdevices connecting to
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their services, and will disallow Internet connentifor invalid MAC
addresses.

e Click Next.

Note: All of the parameters istatic IP connection type should be provided by your

ISP. If you have no idea of them, please ask tRefd® help.

4. PPTP: A service provided by ISPs which requires a usemarpassword and/or

IP address.

PPTP Setting

Username

Password

Get WAN IP Automatically @® Yes QO No
P

Subnet Mask

Gateway

Connect to DNS Server @ Yes QO No
DNS 1

DNS 2

VPN Services

Next

* Username This field is only available when you set the WAMnNnection
Type as PPPoE, PPTP or L2TP.

» Password This field is only available when you set WAN @aation Type
as PPPoE, PPTP or L2TP.

* Get the WAN IP Automatically: SelectYes to get WAN IP automatically
andNo to enter IP manually below.

* IP: If your WAN connection requires a static IP adekey in the IP address
in this field.

* Subnet Mask If your WAN connection requires a static IP addiekey in

the subnet mask in this field.
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* Gateway. If your WAN connection requires a static IP addretype in the
gateway IP address in this field.

e Connect to DNS Server Select Yes to let the device connect to a DNS
Server automatically, or No to enter DNS addressually below.

* DNS1 & DNS2 Both present the IP address of the DNS servéhnelidevice
can’t communicate with DNS1, it will try to commuaie with DNS2.

* VPN Services IP address or DNS for VPN server.

e Click Next.

L2TP requires a username, password and/or IP addresgded by your ISP.

Please reference RPTP setting above.

L2TP Setting

Username

Password

Get WAN IP Automatically @ Yes O No
P

Subnet Mask

Gateway

Connect to DNS Server @ Yes O No
DNS 1

DNS 2

VPN Services

Mext
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Network Setup

After you have clickedNext iconin Internet Setup page, you comes here.

Basic Advanced Wizard

Network Setup

1 | Internet Setup

2 | Network Setup 2.4GHz

3 | Config Overview SSID MySpectrumWiFi50-2G
Key Hi82ywi2CLH
5GHz
D Same as 2 4GHz
SSID MySpectrumWiFi51-5G
Key Uopy8IGmPZx

Apply

1. SSID: Name for a wireless network, that’s to say itsed to identify a wireless
network. Wi-Fi devices automatically detect all wetks within its
communication range, if they own the key.

2. Key: A password used by router to authenticate wisetemnections.

3. When done, cliclApply.
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Config Overview

After click the Apply icon, administrator comes t@onfig Overview page, which
displays a summary of configuration information.thfe settings are all correct,

administrator should clickpply icon.

Basic Advanced Wizard

Config Overview

1 | Internet Setup

2 | Network Setup Connection Type

3 | Config Overview DHCP

DHCP Setting

WAN MAC

Host Name

Use WAN DNS No
DNS Server 1

DNS Server 2

2.4GHz

ssiD MySpectrumWiFin00044-2G
Key AIWSHSYLXyj

SGHz

SSID Iy SpectrumWiFiD00044-5G

Key 5jUDoCorsss
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2.3 Basic Setup

2.3.1 My Router

From the navigation panel, goBasic > My Router.
Basic Advanced Wizard
My Router

Network View >
My Router >
@ Wireless m

Parental Control >

Services >

> O
System o
e

Note: TheResetlcon in the picture is used to restart/rebooteoutanually!

Wireless This module is implemented to configure some dasttings for router’s

wireless connection.

Wireless

2 4GHz

SSID Wy Spectrum\WiFis0-2G
Key Hi82ywi2CLH

5GHz

SSID Wy Spectrum\WiFi51-5G
Key UopyBIGmPZx

1. SSID: A unique name that identifies the wireless nekwireless device can
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automatically detect all networks within its comnuation range. The maximum
length of a SSID is 32 characters.

2. Key: A string used for connection authentication.ldéisgth ranges from 0 to 63
characters(letters, numbers or a combination)anf8 to 64 hex digits.

3. Click Apply.

2.3.2 WPS Setup

WPS (Wi-Fi Protected Setup) is a wireless secwsigndard that allows the device
easily connect to a wireless network. You can guré the WPS function via the PIN

code or WPS button.

WPS

Frequency 2.4GHz "
Enable WPS [ on |

Connection Status WPS-ENROLLEE-SEEN
Configured Yas

AP PIM Code 30649385

WPS Method ® Push Button O Client PIN Code
PIN Code

Steps to enable WPS(Wi-Fi Protected Setup):
1. From the navigation panel, goBasic > My Router.

2. Frequency. Selecting operating band (2.4 GHz or 5 GHz) fd@$\function.

Note: If WPS has been enabled and administrator intemdednge the frequency,

please disable WPS first.

3. Enable WPS Selecting On] to run WPS, witch simplifies the process of

connecting any device to the wireless network
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Note: Authentication methods supported by WPS are: Opestem, WPA-Personal
and WPA2-Personal. Not supported methods are: 8hKey, WPA-Enterprise,
WPA2-Enterprise and RADIUS.

4. Connection Status|& The connection status of WPS.

5. Configured: The configured status of WPS.

6. AP PIN Code Key in the router's PIN code in the client's WBt8ity and
configure the network name and security settings.

7. WPS Method Selects the method to per PIN (Personal Informmatlumber)
method requires a PIN number to establish a wset@snection. PBC (Push
Button Configuration) method requires you to pudbugon (the Start button on
this page or a physical WPS button) to establigir@less connection.

8. PIN Code The WPS PIN code which clients use to connedt thie router.

9. In the WPS Method field, seleBush Button or Client PIN code. If you select
Push Button, go to step 10. If you seleClient PIN code go to step 11.

10.To set up WPS using the router’s WPS button, follbase steps:

a) Click Start or press the WPS button found at the rear of teless router.
b) Press the WPS button on your wireless device. iBhiormally identified

by the WPS logo.

NOTE: Check the wireless router or its user manual fer lbtation of the WPS

button.

11.To set up WPS using the Client’s PIN code, follbmwge steps:
a) Locate the WPS PIN code on your wireless device& umanual or on the
device itself.
b) Key in the Client PIN code on the text box.
c) Click Start to put your wireless router into WPS survey modee Touter’s
LED indicators quickly flash three times until &S setup is completed.

12.Click Start.
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2.3.3 LAN Setup

This module makes it easier for administrator talifyathe default LAN IP Address.

LAN

LAN IP 192.168.1.1
Subnet Mask 2552552550
DHCP Server

Apply

Steps to modify LAN IP settings:

1. From the navigation panel, goBasic > My Router.

2. LAN IP: The LAN IP address of the wireless router. Itfad# value is
192.168.1.1. In IP-based networks, packets are serthe network devices'
specific IP addresses.

3. Subnet Mask Subnet mask of wireless router. Its default valug5§.255.255.0

4. DHCP Server. DHCP (Dynamic Host Configuration Protocol) is ripsised to
allocate IP address for lan-side devices. And a BH€rver can inform lan-side
deviced of DNS server’s address, default gatewagnidPetc. This wireless router

can allocate 253 IP addresses at most.

NOTE: It's recommended for administrator to sel®HCP Server for LAN IP

setting. If not, administrator has to assign IPrads to lan-side device manually.

5. Click Apply.
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2.3.4 WAN Setup

Click WAN button to configure the WAN connection settings:

1. Connection Type Choose the Internet Service type. There are dp#ons are

DHCP, PPPoE, Static, PPTP, and L2TP. Consult y8Brif you are unsure what

kind of WAN connection type to select.

WAN

Connection Type

@® DHCP O PPPoE O Static O PPTP O L2TP

waN MAC

Host Name

D Use WAN DNS
DNS 1
DNS 2

2. If you selectDHCP:

WAN MAC : MAC (Media Access Control) address is a uniquenidier that
identifies your computer or device in the netwol&Ps monitor the MAC
addresses of devices that connect to their serviged would disallow
Internet connection for new MAC addresses.
To fix this issue, you can do either of the follogi
* Contact your ISP and request to update the MAGress associated with
your ISP subscription.

* Clone or change the MAC address of the new aetacmatch the MAC
address of the original device.
Host Name This field allows you to provide a host name \ioreless router.

Usually it's provided by ISP.
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e DNS 1& DNS 2: Either of them indicates IP address of a DNS serve
e Click Apply.

3. If you selectPPPoE
WAN

Connection Type

O DHCP @ PPPoE QO Static Q PPTP Q L2TP
Username
Password |:| Show Password

Connect to DNS Server ® Yes O No
DNS 1
DNS 2

Apply
* Username This field is only available when you set the WAMnNnection
Type as PPPoE, PPTP or L2TP.
» Password This field is only available when you set WAN @aation Type
as PPPoE, PPTP or L2TP.
e DNS1 & DNS2: Either of them indicates IP address of a DNS getivat
wireless router will contact.

* Click Apply.

NOTE: All of the parameters mentioned above are provitlealdministrator has no

idea of these, please consult the ISP.
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4. If you selectStatic, below show the steps to set

WAN

Connection Type

O DHCP O PPPoE @ Static O PPTP O L2TP

P

Subnet Mask
Gateway
DNS 1

DNS 2

WAN Mac

Apply
IP: If WAN connection requires a static IP addressy kn the IP address in
this field.
Subnet Mask If WAN connection requires a static IP addressy kn the
subnet mask in this field.
Gateway. If WAN connection requires a static IP address; ik the gateway
IP address in this field.
DNS 1& DNS 2 Either of them indicates IP address of a DNSeserv
WAN MAC: MAC (Media Access Control) address is a uniquantifier
that identifies your computer or device in the retkyv ISPS monitor the
MAC addresses of devices that connect to theinsesyand would disallow
Internet connection for new MAC addresses.
To fix this issue, you can do either of the follogi
* Contact your ISP and request to update the MAGregb associated with
your ISP subscription.
* Clone or change the MAC address of the new detaceatch the MAC
address of the original device.

Click Apply.
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5. If you selectPPTP:
WAN

Connection Type

O DHCP O PPPoE O Static ® PPTP O L2TP
Username
Password |:| Show Password

Get WAN IP Automatically @ Yes QO No
IP
Subnet Mask

Gateway

Apply

e Username This field is only available when you set the WAMnNnection
Type as PPPoE, PPTP or L2TP.

e Password This field is only available when you set WAN @aation Type
as PPPoE, PPTP or L2TP.

e Get the WAN IP Automatically: Select Yes to get WAN IP automatically
and No to enter IP manually below.

e |P: If WAN connection requires a static IP addressy kn the IP address in
this field.

e Subnet Mask If WAN connection requires a static IP addressy kn the
subnet mask in this field.

e Gateway. If WAN connection requires a static IP address; i the gateway
IP address in this field.

e Click Apply.
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6. If you selectL2TP:
WAN

Connection Type

QO DHCP O PPPoE O Static QO PPTP @ L2TP
Username
Password |:| Show Password

Get WAN IP Automatically @ Yes O No
IP
Subnet Mask

Gateway

Please reference tBPTP above for relevant settings descriptions and etiter

required information.
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2.3.5 Parental Control

Parental Control allows administrator to contr@ behavior of the router.

Basic  Advanced Wizard
Parental Control

Network View >

My Router > Parent Control allows you o control the Intemet access of the child client
you add in To use Parent Control @ HELF

1.You can select and add client by drop-down list of [Client Name] column.
2. Click the plus(+) icon in [Add/Delete] column to add the client you select.

Parental Control >

Services ? 3. You can add schedule in the [Time Management] column. If not, the default action
is 1o use the filters all the time.
System > 4. Select the desired time slots for allowed access times. Drag and hold to create

longer time slots.

5. If you add no filter{url/keyword/service), the default action is to allow all packets
passthrough.

. Click [Confirm] to save the new settings.

Enable Parental Control “

System time Thu Dec 15 04: 04: 31 2016

Client & Schedule List (Maximum: 16)

Client Name Client MAC Time Management Add / Delete

g - (+]

URL Filter List (Maximum: 16)
URL Filter List Add / Delete

o

Keyword Filter List (Maximum: 16)
Keyword Filter List Add / Delete

4]

Service Filter List (Maximum: 16)
Port Range Protocol Add / Delete

TCP 2 [+]

Steps to set parental control function:
1. From the navigation panel, goBase> Parental Control.
2. Enable Parental Control: SelectOn to enable parental control, Selg€aff to

disable parental control.
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3. Client Name Select client from the list. The name in the $igtinds for the client
that is communicating with the router.

4. Client MAC : MAC address of the selected client.

Note: Client Name just makes it easier for administrator to distisulan-side

devices. The&€lient MAC in fact specify the very device under parental cant

5. Add/Delete: Click or to add/delete the profile.

6. Time Management Click , then setup the client’s schedule timetable to

allow or deny client’s access to Internet.

7. URL Filter List : Router prevents lan-side device from accessiadJRL in list.

o]

. Add/Delete: Click or to add/delete the profile.

o

Keyword Filter List: Router prevents lan-side device from accessing to

webpages contain the keyword in list.

10.Add/Delete: Click or to add/delete the profile.

11.Service Filter List: Router prevents lan-side device from communicgtiith
remote device with defined port Hort Rang and definedProtocol.

12.Add/Delete: Click or to add/delete the profile.

13.Click Apply.
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2.3.6 Services

2.3.6.1 USB Printer Sharing

USB Printer sharing allows administrator to plug@B printer to router’s USB port

and set up the print server.

Basic Advanced Wizard
Services > USB Printer Sharing = Add Printer

Network View >

My Router > CGESINEE Printer | Print Jobs

Parental Control >

Services v Available Printers

USB Printer Sharing
HP Deskjet 1000 J110 series [ connue |

FTP Server

Steps to set up USB Printer sharing:
1. From the navigation panel, go Basic > Service > USB Printer sharing > Add
Printer .
2. Plug in the USB interface of the printer to thetesuConfirm your printer has
been detected and click Continue.
3. Select one of the following modes to install thentgr driver, and click Add
printer.

* Auto select Automatically searches for the appropriate prirdgver and
installs. If there is no corresponding printer drivthe system displays add a
printer error; please select the correct printerestrmanually.

» Select printer driver: Manually select the corresponding printer brand a
model.

 Choose PPD Filelf the above methods are unable to correctlyalhshe

printer driver, then you can upload a PPD Filee&gyour PPD file and click
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theupload button.

Basic Advanced Wizard

Services > USB Printer Sharing > Add Printer
Network View >

My Router > GCGRENE Printer Print Jobs

Parental Control >

Services v Available Printers

USB Printer Sharing

Name HP Deskjet 1000 J110 series
FTP Server

Description HP_Deskjet_1000_J110_series
Samba

Choose Model HP Deskjet 1000 j110 Seri... C
WebDAV
DLNA
AFP

4. Printer tab displays whether your printer is operating correatith the print

server, as below.

Basic Advanced Wizard

Services > USB Printer Sharing = Printer

Network View >

My Router > Add Printer Print Jobs
Parental Control >
. Name Details Status Operation
Services v
HP_Deaskjet_1000_J110_series HP_Deaskjet_1000_J110_series Idle 7

USB Printer Sharing
5. To check whether your printer is working correailynot, input the LAN address

(192.168.1.1) for the printer in Windows Finder.

===
OQ [ vagz216811 | 4 || searcn 19218811 ol

Organize Metwork and Sharing Center View remote printers o 0 r@

- Favorites P,

Bl Desktop ,_&
] Recent Places HP_Des‘kje(

& Downloads _1000_i110_
series

- Libraries
':E] Docurmnents
.J'F Music
[l Pictures
;-ﬂ Subversion
= videos

6. Double-click the printer icon and if you see thatss$ interface as shown below,
the installation was successful. If an error messppmpts that the driver
cannot be found, then return fadd Printer settings and select the correct

driver.
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59 HP_Deskjet_1000_1110_series on 192.168.1.1 [ |- [

Printer Document View

Document Mame Status Owner Pages Size Sul

4 LI F

7. You can view print status information in tReint Jobstab.

Basic  Advanced Wizard
Services = USB Printer Sharing > Print Jobs
Network View >

My Router > Add Printer  Printer [ZyT8LJ

@& HELP
Parental Control >
Services v Search

USB Printer Sharing

All Jobs

FTP Server

Samba Print Jobs List

WebDAY

PRINTER SIZE FILENAME STATUS CONTROL

DLNA

* Active: All active jobs, including processing and pendioigs.
* Processing The job currently processing/communicating pdata.

* All Jobs All print jobs.

2.3.6.2 FTP Server

FTP Server enables an FTP server to share files W&B disk to other devices via
your local area network or via the Internet. Thegy@ shows information about the

FTP Server. For set up FTP Server, gAdoanced > Servers > FTP Server
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Basic Advanced Wizard

Services > FTP Server

Network View >

My Router ? Generic_UDISK
Parental Control > SanDisk_Extreme
Services v

USB Printer Sharing FTP

FTP Server

— Enable FTP [ on |

WebDAY Maximum number of Connections 20

DLNA Enable Outside Access Yes

AFP Outside Access 8021

NES Local Access Method ftp://192.168.1.1
System 5 QOutside Access Method ftp://10.8.4.197:8021

Display information on FTP Server:

1. From the navigation panel, goBasic> Services> FTP Server.

2. Connect an extern@SB hard disk drive or USB flash drive to your routand
your device will be displayed here.

3. Enable FTP: Click On/Off to enable/disable Internet accesET® service.

4. Maximum number of Connections the maximum number of concurrent
connections for the Network Neighborhood or FTR/8er

5. Enable Outside AccessSelect On/Off to enable/disable access to FTiresdry
wide area network.

6. Outside AccessThe numbers of external service ports (defadlieze8021).

7. Safely Remove DiskClick to safely remove USB devices. When the Wik is

ejected successfully, the USB status shows 'Nacdévi

2.3.6.3 Samba

Samba Share allows you to set up the accountsemaigsions for the Samba service.
This page shows information about the Samba Sefvar. Samba setup go to

Advanced > Servers > Samba.
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Basic Advanced

Wizard

Services > Samba

Network View >
My Router 2 Generic_UDISK
Parental Control > SanDisk_Extreme
Services v

USB Printer Sharing Sa mba

FTP Server

Samba Enable Share m

WebDAV Device Name RT4230W

DLNA Work Group Waorkgroup

AEP Account admin

NFS Samba Access Path 162 168.1.1

From the navigation panel, goBasic> Services> Samba Server

Connect an extern&SB hard disk drive or USB flash drive to your routand
your device will be displayed here.

Enable Share Click the On/Off to enable/disable Internet ascés Samba
service.

Device Name Enter a name for your device and you can usertiise in your
web browser's URL field to quickly access the dewds a Network Place service.
Work Group : Group name of the router in Network Neighborhood.

Safely Remove Disk Click to safely remove the disk. When the USBkdis

ejected successfully, the USB status shows 'Nacdévi
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2.3.6.4 WebDAV

The client can write operations in WebDAV directarnth appropriate permissions.
This page shows information about the WebDAV SerVerset up WebDAV go to
Advanced > Servers > WebDAV.

Basic  Advanced Wizard
Senvices = WebDAV
Network View >

MyRouer > G upisk

Parental Control > SanDisk_Extreme Safely Remove Disk

Services v
USE Printer Sharing
FTP Server WEbDAV
Samba Enable WebDAV m
WebDAV HTTP Access Port 80
DLNA HTTPS Access Port 443
IR Enable Qutside Access Yes
NFS Outside Access HTTP B0OBO
System > Outside Access HTTPS 8443
LAN
WebDAY HTTP Access Path http:#1192.168.1.1:80/LUU
WebDAV HTTPS Access Path hitps:/192.168.1.1:443/UU0
WebDAV HTTP Access Path hitp:/1192.168.1.1:B0/UNTITLED
WebDAV HTTPS Access Path https:/1192.168.1.1:443/JUNTITLED
WAN
WebDAY HTTP Access Path http:#10.8.4.197:8080/UUL
WebDAV HTTPS Access Path hitps:/10.8.4.197:844 3000
WebDAV HTTP Access Path hitp:/110.8.4.197:8080/UNTITLED
WebDAV HTTPS Access Path https:/10.8.4 197 844 3/JUNTITLED

1. From the navigation panel, goBasic> Services> WebDAV Server.
2. Connect an external USB hard disk drive or USBHhfldgve to your router, and
your device will be displayed here.

3. HTTP Access Port The port to access the WebDAV server for HTTRgeol in
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the local area network (default value: 80).

4. HTTPS Access Port The port to access the WebDAV server for HTTP&qaol
in the local area network (default value: 443).

5. Enable Outside AccessSelect On/Off to enable/disable access to WebDAV
server by wide area network.

6. Outside Access The port number of external service ports via RT(Oefault
value: 8080).

7. Outside Access HTTPSThe port number of external service ports via RBT
(default value: 8443).

8. Safely Remove Disk Click to safely remove the disk. When the USBkds

ejected successfully, the USB status shows 'Nacdévi

2.3.6.5 DLNA

DLNA (Digital Living Network Alliance) allows youd share audio, image and video.
Your router allows DLNA-supported devices to acaasstimedia files from the USB
disk connected to your router. This page showsrin&bion about the DLNA Server.

To setup a DLNA server, go fadvanced > Servers > DLNA.

Basic  Advanced Wizard
Services > DLNA

Network View
My Router ’ Generic_UDISK
Parental Control > SanDisk_Extreme
Services v

USB Printer Sharing D L NA

FTP Server

S Enable DLNA Media Server [ on |

WebDAV Media Server Name OpenWrt DLNA Server

DLNA

Steps to set DLNA:
1. From the navigation panel, goBasic> Services> DLNA.

2. Connect an external USB hard disk drive or USBHhfldgve to your router, and
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your device will be displayed here.

3. Enable DLNA Media Server. Switch DLNA media server on or off.

4. Media Server Name The DLNA server's name, which will be displayedthe
media player such as VLC or Windows Media Player.

5. Safely Remove Disk Click to safely remove the disk. When the USBkds
ejected successfully, the USB status shows 'Nacdévi

2.3.6.6 AFP

An AFP server is a kind of network file sharing \&&r based on AFP protocol

implementation, mainly used for file sharing betwéénux and MAC systems. This

page shows information about the AFP server. Taps&FP, go to Advanced >

Servers > AFP.

Basic Advanced Wizard

Services = AFP

Network View >

My Router > Generic_UDISK
Parental Control > SanDisk_Extreme
Services v
USB Printer Sharing AFP
FTP Server
—_— Enable Share Ex
WabDAV AFP Access Path afp://192.168.1.1
DLNA
AFP
Steps to set AFP:
1. From the navigation panel, goBasic> Services> AFP.
2. Connect an external USB hard disk drive or USBHhfldgve to your router, and
your device will be displayed here.
3. Enable Share Click On/Off to enable/disable AFP service.
4. Safely Remove Disk Click to safely remove the disk. When the USBkds

ejected successfully, the USB status shows 'Nacdéevi
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2.3.6.7 NFS

Network File System Server is used to share the OJiSB with clients via network.
Clients can mount the remote disk to a local doscfor a faster speed than using a
Samba serveiThis page shows information about the NFS Seiesetup NFS, go

to Advanced > Servers > NFS.

Basic Advanced Wizard

Services > NFS

Network View >
My Router > Generic_UDISK
Parental Control > SanDisk_Extreme
Services v

USB Printer Sharing N FS

FTP Server

I Enable NFS [ on |

WebDAV
DLNA
AFP
NFS

Steps to set NFS:

1. From the navigation panel, goBasic> Services> NFS.

2. Connect an external USB hard disk drive or USBhfldsve to the router, then
device’s name will be displayed here.

3. Enable NFS Enable or disable NFS service. When disabled;susan't access
the USB storage via the NFS service.

4. Safely Remove Disk Click to safely remove the disk. When the USBkdis

ejected successfully, the USB status shows 'Nacdévi

36



2.3.7 System

The system module allows administrator to configuoeiter. Administrator can
change the username and password used to logihetorauter GUI and other

miscellaneous settings such as Time Zone, Auto ubgod NTP Server.

Basic  Advanced Wizard
System
Network View >

My Router > Change the Router Login Password

Parental Control >

Username admin
Services > New Password
System > Retype New Password D Show Password

Miscellaneous

Time Zone America/New York -

Auto Logout 0 Minutes (Disable: 0)

NTP Server ( Maximum:6 )

NTP Server Add/Delete
&3
us.pool.ntp.org =l
north-america.pool.ntp.org (]
time.nst.gov (-]
pool.ntp.org e

Steps to set the System settings:

From the navigation panel, goBasic> System

Username name used to login router.

New Password New login password for router.

Retype New PasswordRetype new login password for router.
Time Zone The time zone used by default.

Auto Logout: Auto logout after a specified period of time.

N o g & w NP

NTP Server. DNS of a NTRPNetwork Time Protocol¥erver.
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8. Click Apply.

2.4 Advanced Setup

2.4.1 Network

2.4.1.1 WAN Settings

2.4.1.1.1 Internet Settings

Router supports several WAN connection types. $elee type from the WAN

Connection Type dropdown menu.

Basic Advanced Wizard

Network = WAN > Internet

Network v
WAN ==Y ooNS | UPP Port Trigger | Port Forward | DMZ | NAT Pass Through
LAN
Wireless .
e Basic
Parental Control WAN Connection Type DHCP o
Multicast MTU 1500
Routing
Services ’ WAN DNS Settings
i >
Security Connect to DNS Server ® Yes O No
Qos > DNS 1 10.7.46.1
Admin > DNS 2 61.139.2 69
Tools >
Status > Account Settings
Authentication ® Mone © 802.1x MD5
Username
Password

Special Requirement

Host Name
MAC Address
DHCP Query Frequency Agressive Mode o
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Steps to configure WAN connection settings:

1.
2.

10.

11.

12.
13.

14.

From the navigation panel, goAalvanced > Network > WAN > Internet.

WAN Connection Type Choose the Internet Service Provider type. Tlaeee5
options:DHCP, PPPoE, Static , PPTP, and L2TPIf you are unsure which type
to select, please consult your ISP.

MTU: Maximum Transmission Unit value, which defines th@ximum length of
a packet.

Connect to DNS Server Allows router to get IP address from the DNS $&erv
automatically. DNS Server is a host on the Intethat translates Internet names
to numeric IP addresses.

Get WAN IP Automatically: SelectYesto get WAN IP automatically ando to
enter IP manually below.

IP Address If your WAN connection requires a static IP addiekey in the IP
address in this field.

Subnet Mask If your WAN connection requires a static IP addiekey in the
subnet mask in this field.

Default Gateway. If your WAN connection requires a static IP addrdgpe in
the gateway IP address in this field.

DNS 1 & DNS 2:Either of them indicates an IP address of a DN@ese
Authentication: Use 802.1x MD5 authentication or not (IEEE 8024 an IEEE
Standard for port-based Network Access Control).

Username Username for 802.1x MD5 authentication.

Password Password for 802.1x MD5 authentication.

PPTP Options PPTP Encryption method. Select Auto for automaticrisoft
Point-to-Point Encryption (MPPE) and select No BEption to disable MPPE.
Select MPPE 40 for 40-bit MPPE with PPTP Server seléct MPPE 128 for
128-bit MPPE with PPTP Server.

Access Concentrator NameSpecifies the Access Concentrator to connedf to.
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unset, pppd uses the first discovered one.

15. Additional Pppd Options: Additional command line arguments to pass to the
pppd daemon.

16. Host Name This field allows you to provide a host name yowr router. It is
usually provided by ISP.

17. MAC Address: MAC address identifies a device in the netwo&P$ monitor
the MAC addresses of devices that connect to gwirices, and would disallow
Internet connection for new MAC addresses.

To fix this issue, you can do either of the follogi

* Contact your ISP and request to update the MA@regs associated with your
ISP subscription.

* Clone or change the MAC address of the new detgageatch the MAC address
of the original device.

18. DHCP Query Frequency Some ISP blocks MAC addresses if the device makes
DHCP queries too often. To prevent this, changeDHEP Query Frequency. In
the default Aggressive mode, if your wireless rodl@es not get a response from
the ISP, it sends another query after 20 secondsrakes three more attempts.
In Normal mode, if your wireless router does nat geesponse from the ISP, it
makes a second query after 120 seconds and makesdve attempts.

19. Enable Default Route Whether to create a default route over the tunnel.

20. VPN Server. IP address or DNS for VPN server.

21. Click Apply.

2.4.1.1.2 DDNS

Setting up DDNS (Dynamic DNS) allows you to get e to your router from
outside through the provided wireless router DDNBvBe or another DDNS service.
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Basic Advanced Wizard

Network = WAN > DDNS

Network v
AN Internet m UPnP  Port Trigger  Port Forward | DMZ | NAT Pass Through
Lo (o e
Wireless NetAPEh
IPv6 .
Basic
Parental Control
Multicast Enable the DDNS Clent @Yes O No
Routing Server www.dyndns.com Free Trial
. Host Name
Services >
: ) Username or E-mail Address
Security >
Password or DDNS Key
Qos
Admin

Steps to set up DDNS:

1.
2.

From the navigation panel, goAalvanced > Network > WAN > DDNS.

Enable the DDNS Client Yes means enable DDNS functioNp means disable
DDNS function.

Server. Select the Supported DDNS provider’s URL from like

Host Name Specifies the host name to be updated.

User Name or E-mail Address User name or email address which has been
registered an account in a DDNS provider.

Password or DDNS Key Password is your registered account.

Click Apply.

NOTES: DDNS service will not work properly under theseadibions:

When the wireless router is using a private WAN dédress (192.168.x.x,
10.x.x.x, or 172.16.x.x), as indicated by yellowtte

The router works on a network who uses multiple N&Gles.

2.4.1.1.3 UPnP

UPNnP (Universal Plug and Play) allows devices (saglrouters, televisions, stereo

41



systems) to be controlled via an IP-based netwdtk wr without a central control

unit. Under the help of UPnP, one device can beodisred once it has connected to

network, then device can be remotely configuredstpport P2P applications,

interactive gaming, video conferencing, and webpooxy servers. Unlike Port

forwarding, UPnP automatically configures the rotwiteaccept incoming connections

and direct requests to a specific PC on the loeavork.

Basic Advanced Wizard

Steps to set up UPn
1.
2.

Network = WAN > UPnP

Network v
WAN Internet | DDNS m Port Trigger Port Forward  DMZ |~ NAT Pass Through
LAN [ & HELA
Wirsless .
B Basic
Parental Control Enable UPnP ®vYes O No
Multicast Advertisement Pericd 30 Seconds
feutng Advertisement Time To Live 2 hops
Services >
Security >

F

From the navigation panel, goAalvanced > Network > WAN > UPnP

Enable UPnP. Yesmeans enable UPnP aNd means disable it.

Advertisement Period Router will broadcast its UPnP information to @dvices
every advertisement-period seconds.

Advertisement Time To Live Number of hops that an advertisement will be
transmited .

Click Apply.

2.4.1.1.4 Port Trigger

Port trigger mechanism first defines a pdrigger Port), when a lan-side device has

written data to this defined port, the incomingad&tom incoming port will be

forwarded to same port of the device who has aeti/ehis mechanism.
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Basic Advanced Wizard

Network > WAN > Port Trigger

Network v
WAN Internet  DDNS  UPnP REEh@pubLEl Port Forward DMZ  NAT Pass Through
L (@ HELP |
Wireless
. Basic
Parental Control Enable Port Trigger OYes @No
Multicast Well-Known Applications Please Select
Routing
Services . Trigger Port List (Maximum: 32)
Security > Description Trigger Port Protocol Incoming Port Protocol ~ Operation
B N TCP ¢ TCP ¢ [+
Adnin >

Steps to set up Port Trigger:
1. From the navigation panel, goAalvanced > Network > WAN > Port Trigger.

2. Enable Port Trigger: Check to enable or disable Port Triggering.

3. Well-Known Applications: Select popular games and web services to adueto t

Port Trigger List.

4. Description: A brief description for application.

5. Trigger Port: When there is incoming data from lan-side appilbeato this port,
thePort Trigger mechanism will be activated.

6. Protocol: Select the type of protocol that the applicatioh use.

Incoming Port: Defines the range of port. After Port trigger im&cism has been
activated, the data from port within this range Iwie forwarded to the
corresponding port of the application who has atég Port trigger mechanism.
Operation: Add, Edit or Delete operation for this item.

Click Apply.

Note: Trigger Port elementn the list is regarded as a trigger, that’s to wagn data

comes to this port, the Port Trigger mechanism béllactivated.
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2.4.1.1.5 Port Forward

Port forwarding is a method used to direct netwaakic from Internet to a specified

port. Setting up Port Forwarding allows trafficrftroutside to get access to specified

services provided by lan-side device.

Basic Advanced

Network
WAN
LAN
Wireless
IPv6
Parental Control
Multicast

Routing

Services
Security
Qos
Admin

Tools

Network = WAN > Port Forward

Internet  DDNS UPNP | Port Trigger BaeldssIVEIGH DMZ  NAT Pass Through

Basic
Well Known Server List Please Select
Well Known Game List Please Select

Port Forwarding List (Maximum: 128)

Services Public [P Port Range Local IP Local F

NOTE: When Port Forward is enabled, router blocks unsolicited inboundficaf

from the Internet and only allows replies from auibhd requests from the LAN. The

network client does not have access to the Intetinettly, and vice versa.

Steps to set up Port Forwarding:

1. From the navigation panel, goAalvanced> Network> WAN>Port Forward.

2. Enable Port Forwarding: Check to enable or disable Port Forwarding.

3. Well Known Server List: Select a pre-defined Server list from the dropsdo

menu and the Port Forwarding List will be autoefil]

4. Well Known Game List: Select a game from the Server list and the Port

Forwarding List will be auto-filled.

5. Services A short description about this service.

6. Public IP: IP address of WAN Port.
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7. Port Range Defines the range of port in wan side.

NOTES:

A network makes use of ports in order to excharga,dvith each port assigned
a port number and a specific task. For examplet @oris used for HTTP. A

specific port can only be used by one applicatiosesvice at a time. Hence, two
PCs attempting to access data through the samafpibreé same time would fail.

For example, you cannot set up Port Forwardingotot 100 for two PCs at the
same time.

When your network’s firewall is disabled and you 88 as the HTTP server’s
port range for your WAN setup, then your http sefweb server would be in

conflict with the router’s web user interface.

. Local IP: Key in the client’s LAN IP address.

. Local Port: Enter a specific port to receive forwarded paskéeave this field

blank if you want the incoming packets to be retded to the specified port

range.

10.Protocol: The required protocol. Refer to the documentafamnthe service that

you are hosting.

11.Operation: Add, Edit or Delete operation for this item.
12.Click Apply

Steps to check whether Port Forwarding module bas lctivated successfully:

* Ensure that your server or application is set upranning.

* You will need a client outside your LAN which haddrnet access (referred to as

“Internet client”). This client should not be comted to the wireless router.

* On the Internet client, use the router’s WAN IPaccess the server. If port

forwarding has been successful, you should be abbe access

available/specified files or applications.

Differences between port trigger and port forward:
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* Port triggering will work even without setting upsaecific LAN IP address.
Unlike port forwarding, which requires a static LAR address, port triggering
allows dynamic port forwarding using the routered®termined port ranges are
configured to accept incoming connections for aitéoh period of time. Port
triggering allows multiple computers to run applicas that would normally
require manually forwarding the same ports to daClon the network.

* Port triggering is more secure than port forwardsngce the incoming ports are
not open all the time. They are opened only whem@gplication is making an

outgoing connection through the trigger port.

2.4.1.1.6 DMZ

Virtual DMZ module exposes one client to the Ing#rrallowing this client to receive
all inbound packets directed to a Local Area Nekwdnbound traffic from the
Internet is usually discarded and routed to a §petdient only if port forwarding or a
port trigger has been configured on the network.allDMZ configuration, one
network client receives all inbound packets.

Setting up DMZ on a network is useful when you neexming ports open or you

want to host a domain, web, or e-mail server.

CAUTION: Opening all of the client’s ports to Internet makies network vulnerable

to outside attacks. Please be aware of the secigkiy involved in using DMZ.
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Basic Advanced Wizard

Network > WAN = DMZ

Network v
WAN Internet  DDNS  UPnP  Port Trigger  Port Forward m NAT Pass Through
LAN
Wireless
- Basic
Parental Control Enable DMZ @Yes ONo
Multicast IP Address of Exposed Station
Routing Enable IPv6 DMZ @Yes ONo
Services > IPv6 Address of Exposed Station
Security 3 IPw6 prefix for DMZ setting Mo prefix for ipve DMZ setting!
o )

Steps to set up DMZ:

1. From the navigation panel, goAalvanced > Network > WAN > DMZ.

2. Enable DMZ: Check to enable or disable DMZ.

3. IP Address of Exposed StationLAN IP address of a client who can provide
DMZ service. This makes the device with this IP radd expose to Internet.
Make sure that the server client has a static tiPesd.

4. Enable IPv6 DMZ: Check to enable or disable IPv6 DMZ.

5. IPv6 Address of Exposed StationThe client's LAN IPv6 address that will
provide the DMZ service and be exposed on theneter

6. IPv6 prefix for DMZ setting: The IPv6 DMZ address must be in the range of
IPv6 prefix. Show it for user to set valid DMZ adds.

7. Click Apply.
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2.3.1.1.7 NAT Pass Through

NAT Pass Through allows a Virtual Private NetwolP{) connection to pass

through the router to the network server.

Basic Advanced Wizard

Network = WAN > NAT Pass Through

Network v
WAN Internet  DDNS UPnP  Port Trigger Port Forward DMZ ENEYEzEEEREI])
LAN
Wireless
s Basic
Parental Control PPTP Passthrough Enable
Multicast L2TP Passthrough Enable
Fautng IPSec Passthrough Enable
Services SSL Passthrough Enable
Security RTSP Passthrough Enable
Qos H.323 Passthrough Enable
; SIP Passthrough Enable
Admin 8
NORM Passthrough Enable
Tools
Enable PPPoE Relay Disable
Status

Steps to set up NAT Pass Through:

1. To configure NAT Pass Through settings, gdAttvanced > Network > WAN >

NAT Pass Through.

2. PPTP Passthrough Enable or disable. Point-to-Point Tunneling Pcotqd PPTP)

is a method for implementing virtual private netisor

3. L2TP Passthrough Enable or disable. In computer networking, Lay&r

Tunneling Protocol (L2TP) is a tunneling protocskd to support virtual private

networks (VPNSs) or as part of the delivery of seegi by ISPs. It does not provide

any encryption or confidentiality by itself.

4. IPSec Passthrough Enable or disable. Internet Protocol Securitysél®) is a



protocol suite for securing Internet Protocol (IRPmmunications by
authenticating and encrypting each IP packet amancunication session.

. SSL Passthrough Secure Sockets Layer(SSL) is cryptographic padc¢hat
provide communications security over a computewaek.

. RTSP Passthrough Enable or disable. The Real Time Streaming PobtRTSP)
is a network control protocol designed for use integainment and
communications systems to control streaming meshaess.

. H.323 Passthrough Enable or disable. H.323 is a recommendation filoenlTU
Telecommunication Standardization Sector (ITU-Tgttdefines the protocols to
provide audio-visual communication sessions ongatket network.

. SIP Passthrough Enable or disable. The Session Initiation Protd&P) is a
communications protocol for signaling and contrgli multimedia
communication sessions. The most common applicatanSIP are in Internet
telephony for voice and video calls, as well asansmessaging all over Internet
Protocol (IP) networks.

. NORM Passthrough Enable or disable. NACK-Oriented Reliable Mulsta
(NORM) Transport Protocol, which can provide enetta reliable transport of
bulk data objects or streams over generic IP nadticouting and forwarding

services.

10.Enable PPPoOE Relay. PPPoE relay allows devices in LAN to establish an

individual PPPOE connection that passes through. NAT

11.When done, cliclApply.
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2.4.1.2 LAN Settings

2.4.1.2.1 LAN
The LAN IP module allows administrator to modifytaide IP address of the router.

Basic Advanced Wizard

Network = LAN = LAN IP

Network v
WAN DHCP Server
LAN
Wireless
= Basic
Parental Control IP Address 182.168.1.1
Multicast Subnet Mask 255.255.255.0
Routing
Services >

Steps to modify the LAN IP settings:

1. From the navigation panel, go to Advanced > NetwotkAN > LAN IP.

2. IP Address The LAN IP address of wireless router. The ddfawdlue is
192.168.1.1. In IP-based networks, data packetsemtto the network devices'
specific IP addresses.

3. Subnet Mask The LAN subnet mask of wireless router. Its défaalue is
255.255.255.0

4. Click Apply.

NOTE: Any change to the LAN IP module will affect rou®DHCP settings.
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2.3.1.2.2 DHCP Server

DHCP server can assign each client an IP addressndorms the client of DNS
server’s IP, default gateway’s IP and etc. Thieless router can allocate up to 253 IP

addresses for lan-side devices.

Basic Advanced Wizard

Network = LAN > DHCP Server

Network v
LAN [ O HELP)
Wireless
- Basic
Parental Control Enable DHCP Server @Yes ONo
i Domain Name lan
Beuig IP Pool Starting Address 192.168.1.2
Services > IP Pool Ending Address 192.168.1.254
Security > Lease Time 604800
Qos 5 Default Gateway 192.168.1.1
Admin >
Tools X DNS and WINS Server
Status > DNS Server 192.168.1.1

WINS Server

Static IP Assignment within DHCP IP Pool (Maximum:

64)
Enable Manual ® Yes O No
MAC IP Add/Delete
g [+

Steps to configure the DHCP server:

1. From the navigation panel, goAalvanced > Network > LAN > DHCP Server

2. Enable DHCP Server Enable DHCP server function which allows route@att
as a DHCP server to automatically assign IP addsessnetwork clients. If this
function is disabled, administrator has to manusdliyLAN devices.

3. Domain Name Domain Name for clients who request IP AddressnflDHCP
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Server. This field only contains alphanumeric chaes and dash symbols.

4. |IP Pool Starting Address Starting address that can be allocated to lam-sid
devices.

5. IP Pool Ending Address Ending address that can be allocated to lan-side
devices.

6. Lease Time Defines the time that lan-side devices can use absigned IP
address. When the lease time expires, the netwierit evill either send renew or
rebind message to a DHCP server.

7. Default Gateway. IP address of the gateway for LAN.

8. DNS Server IP address of a DNS server. DNS Server is useddolve a DNS
into a numerical IP Address. By default, the routdract as a DNS server.

9. WINS Server. Windows Internet Naming Service manages intevastiof each
PC with the Internet. If you use a WINS servereerthe IP Address of server
here.

10. Enable Manual: Assign fixed IP address for clients.

11. MAC : MAC address of lan-side device.

12. IP: IP address within DHCP IP Pool for an-side device

13. Add/Delete Add/Delete static IP.

14. Click Apply.

NOTES:
» We recommend that administrator use an IP addoessat of 192.168.1.xxx (where
XXX can be any number between 2 and 254) whenfgperan IP address range.

* An IP Pool Starting Address should not be gredian the IP Pool Ending Address.
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2.4.1.3 Wireless Settings

2.4.1.3.1 Basic

Basic settings allow you to set up the basic wasleettings.

Basic Advanced Wizard

Network > Wireless > Basic

Network v
WAN =1 wps AcL Professional Radio Guest
LAN [ @ HELP
Wireless
- Basic
Parental Control Frequency 2 4GHz o
Multicast Index 1 2
Houng SSID Enable @Yes ONo
Services > SsID MySpectrumWiFi50-2G
Security 3 Hide SSID OvYes @ No
Qos 3 Authentication Method WPA2 Personal <
Admin . WPA Encryption AES :
WPA Pre-shared Key Hi82ywi2CLH
Tools >
Protected Management Frames Disable T
SEE ’ Max Clients 128
Network Key Rotation Interval 3600

Steps to set up the basic wireless settings:
1. From the navigation panel, goAalvanced > Network > Wireless 3Basic.
2. Frequency. Select the frequency band to configure.

3. Index: Indicates witch SSID is under setting.

Note: At present time, the router supports 8 SSIDsr@ater usesndex parameter to

indicate witch SSID is under configuration.

4. SSID Enable Switch the SSID on/off (enable/disable).
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10.

11.
12.

13.

SSID: A name whose length is less than 32 charactenssésl to identify a
wireless network. WiFi devices automatically detadlt networks within its
communication range.

Hide SSID: If [Yed is selected, SSID does not show in site surveysibeless
mobile clients and they can only connect to wirglesiter by manually entering
SSID.

Authentication Method: This field enables authentication methods foreless
clients.

WPA Encryption: Enable WPA Encryption to encrypt data.

WPA Pre-Shared Key Requires a password of 8-63 characters (letbensibers
or a combination) or 8 - 64 hex digits to startéineryption process.

Protected Management FramesProtected Management Frames is a feature to
protect some types of management frames like deamé#tion, disassociation
and action frames.

Max Clients: The maximum number of clients allowed.

Network Key Rotation Interval: This field specifies the interval (in seconds)
after which a WPA group key is changed. Enter (r@) to indicate that a
periodic key-change is not required. Please inpaitvlue between 600 to 86400
(seconds).

Click Apply .
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2.4.1.3.2 WPS

WPS (Wi-Fi Protected Setup) is a wireless secwtizmdard that allows you to easily
connect devices to a wireless network. You canigard the WPS function via the
PIN code or WPS button. WPS supports the authdiaiicaof Open system,
WPA-Personal and WPA2-Personal. Not supported: ésh&ey, WPA-Enterprise,
WPA2-Enterprise and RADIUS.

Basic Advanced Wizard

Network = Wireless = WPS

Network v
WAN Basic ACL Professional Radio Guest
LAN (O HELP |
Wireless Note: ACL will only take effect when WPS is disabled
IPv6 .
Basic
Parental Control
Multicast Frequency 2.4GHz
Routing Enable WPS Ex
Services 5 Connection Status WPS-ENROLLEE-SEEN
. Configured Yes
Security >
AP PIN Code 30649385
Qos >
WPS Method ® Push Button O Client PIN Code
i >
Admin PIN Code
Tools >
Status >

Steps to set WPS:

1. From the navigation panel, goAalvanced> Network > Wireless> WPS.

2. Frequency. Select an operating band (2.4 GHz or 5 GHz) fd?SVTo change
the operating band, please disable the WPS funfit&in

3. Enable WPS Selecting On] to enable WPS. This can simplify the process of

connecting any device to the wireless network.

NOTE: WPS supports authentication using Open System, Wé&#&eonal, and
WPA2 - Personal. WPS does not support a wirelesgank that uses a Shared Key,
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WPA-Enterprise, WPA2-Enterprise, and RADIUS endgmpimethod

4. Connection Status The connection status of WPS.

5. Configured: The configured status of WPS.

6. AP PIN Code This is your router's WPS PIN code. Enter thisha client's WPS
utility to make a connection.

7. WPS Method PIN (Personal Information Number) method requyes to enter
a PIN number to establish a wireless connection.C P@ush Button
Configuration) method requires you to push a buftine Start button on this
page or a physical WPS button) to establish a essetonnection.

8. To set up WPS using the router’s WPS button:

a) Click Start or press the WPS button found at the rear of theless router.
b) Press the WPS button on your wireless device. ishi®rmally identified by
the WPS logo.

NOTE: Check your wireless device or its user manual ler Ibcation of the WPS

button.

9. To set up WPS using the Client’s PIN code:
a) Locate the WPS PIN code on your wireless device& mmanual or on the
device itself.
b) Key in the Client PIN code on the text box.
c) Click Start to put your wireless router into WPS survey modee Touter’s
LED indicators quickly flash three times until W&PS setup is completed.
10. PIN Code The WPS PIN code for clients to connect using Riéthod.
11. When doneglick Start.
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2.4.1.3.3 ACL

ACL can be used to allow or disallow one devicedgnd packets.

Basic Advanced Wizard
Network = Wireless > ACL

Network e
WAN Basic WPS F:\&B Professional Radio Guest
LAN
: Note: ACL will only take effect when WPS is disabled.
Wireless
IPvG %
Basic
Parental Control
Multicast Frequency 2 4GHz
Routing Index 1
S 5 SSID Name MySpectrumWiFi50-2G
. ‘ Enable MAC Filter O Yes @ No
Security >
MAC Filter Mode Accept
Qos >
Admin > MAC Filter List (Maximum: 64)
Tools > MAC Filter List Add / Delete
Status > s ()

Steps to set up the ACL:

1. From the navigation panel, goAalvanced > Network > Wireless > ACL

2. Frequency: In the frequencyield, select the frequency band that you wantge u

for the ACL settings.
3. Index: Indicate witch SSID is going to apply ACL rules.
4. SSID Name A name whose length is less than 32 charactarsad to identify a
wireless network.
5. Enable MAC Filter: Enable MAC filter or disable.
6. MAC Filter Mode : SelectAccept to allow devices in the MAC filter list to

access to the wireless network, selRRefectto prevent devices in the MAC filter

list from access to the wireless network.
7. MAC Filter List : Enter the MAC address of the wireless device. Mi@ring
allows users to either limit specific MAC addresd$esn associating with the
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AP/router, or specifically indicates which MAC addses can associate with the
AP/router.

8. When doneglick Apply.

2.4.1.3.4 Professional

The Professional module provides advanced configuraptions.

Basic Advanced Wizard

Network > Wireless > Professional

Network v
WAN Basic WPS ACL Radio Guest
LAN
Wireless
- SSID Setting
Parental Control Frequency 2 4GHz -
Multicast Index 1 -
gouing SSID MySpectrumWiFi50-2G
Services > Enable TX STBC Enable :
Security > Enable RX STBC Enable °
Qos > Set AP Isolated O Yes ® No
Admin 5 Multicast Rate (Mbps) Auto :
Short Guard Interval Enable °
Tools >
DTIM Interval 3
Status >
Enable WMM Enable :
Enable WMM APSD Enable z
Turbo QAM Enable °
Universal Beamforming Disable o

Disable Specific MCS Data Rates

30 29 28 27 26 25 24 23 22 18 17

m[ujnln mujulm DDDD DDDD
o o o o o o R [
T

NOTE: We recommend that administrators use the defatiihgs.

In this module, administrator can configure thédeings:
1. From the navigation panel, go tddvanced > Network > Wireless >

Professional.
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10.

11.

12.

13.
14.

Frequency. Select the frequency band to configure profesdisattings.

Index: Indicates witch SSID is under setting.

SSID: A name whose length is less than 32 charactenssésl to identify a
wireless network.

Enable TX STBC:. Enables or disables the Space Time Coding BI&KBC)
feature, as described in 802.11n specificatiotransmitting (TX) direction.
Enable RX STBC. Enables or disables the Space Time Coding BI&IBC)
feature, as described in 802.11n specificatione@eiving(RX) direction.

Set AP Isolated Prevent wireless devices from communicating veidith other
via router. This feature is useful if many guestxjfiently join or leave your
network. SelectYes]to enable this feature or selebld] to disable.

Multicast Rate (Mbps): Setting transmission rate for multicast.

Short Guard Interval : Defines the length of time that the router speiod<RC
(Cyclic Redundancy Check). CRC is a method of detgcerrors during data
transmission. SeledEnable for a busy wireless network with high network
traffic.

DTIM Interval : DTIM (Delivery Traffic Indication Message) Inteal or Data
Beacon Rate is the time interval before a signaeist to a wireless device in
sleep mode indicating that a data packet is avgpd#livery. The default value is
three milliseconds.

Enable WMM : Enables or disables WMM capabilities in the drividie WMM
capabilities perform special processing for multilmestream data including
voice and video data.

Enable WMM APSD: Enable WMM APSD (Wi-Fi Multimedia Automatic
Power Save Delivery) to improve power managemetwdsn wireless devices.
SelectDisableto switch off WMM APSD.

Turbo QAM : 256-QAM (MCS 8/9) support. Wireless Mode must betgauto.
Universal Beamforming. For legacy wireless network adapters which do not
support beamforming, the router estimates the channel and determines th

steering direction to improve the downlink speedls¢ known as Implicit
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Beamforming)

15. Click Apply.

2.4.1.3.5 Radio

Administrator can set some advanced feature fao rafcthe router.

Basic Advanced Wizard

Network
VAN
LAN
Wireless
IPvE
Parental Contral
Multicast

Routing
Services
Security
Qos
Admin
Tools

Status

Steps to set Radio:

Network = Wireless = Radio

Basic WPS ACL Professional JRELRLY Guest

Basic

Frequency

Schedule

Enable Wireless Scheduler

Radio Setting

Enable Radio

Wireless Mode

Channel Bandwidth
Control Channel

Enable TX Bursting

Tx Power Adjustment
OBSS RSS!

RTS Threshold
Fragmentation Threshold
Beacon Interval

AMPDU Aggregation
VHT AMPDU Aggregation
DCS Enable

Radio Resource Managment

2.4GHz

OvYes @No

® Yes O No
big/n
[ ]btg Protection
20 MHz
Auto
Enable
100%
3
2347
2346
100
3
7
Disable
Enable

1. From the navigation panel, goAavanced> Network > Wireless> Radio.
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Frequency: Selecting the frequency band that the routernsing.
Enable Wireless SchedulerSwitch wireless schedule on or not.
Date to Enable (Weekdays)Select weekdays to enable Wi-Fi.
Time of Day To Enable Set weekday time to enable Wi-Fi.

Date to Enable (Weekend)Select weekend days to enable Wi-Fi.

Time of Day To Enable Set weekend time to enable Wi-Fi.

© N o 00 B~ W N

Enable Radia Select Jes] to enable wireless radio (wireless network). Select

[No] to disable wireless radio (wireless network).

9. Wireless Mode Select a Wireless Mode of your 802.11n interface.

10. Channel Bandwidth: Sets manual channel bandwidth.

11. Control Channel: The radio channel for wireless connection operati

12. Enable TX Bursting: TX Bursting improves transmission speed betweener
and 802.11g devices.

13. Tx Power Adjustment: Set the capability for transmission power. Theimam

value is 100%. You can save power and increaseisetfuyou don't require full

wireless range.

NOTE: Increasing the Transmission Power adjustmentegainay affect the stability

of the wireless network.

14. OBSS RSSI Configure OBSS RSSI threshold. If OBSS RSSI isatgr than
configured value, then only move to 20 Mhz.

15. RTS Threshold Select a lower value for RTS (Request to Sendedhold to
improve wireless communication in a busy or noisgelgss network with high
network traffic and numerous wireless devices.

16. Fragmentation Threshold Set the fragmentation threshold, which is the
maximum fragment size.

17. Beacon Intervalt Beacon Interval means the period of time betwea®® beacon

and the next one. The default value is 100 (thé ignmillisecond, or 1/1000
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18.

19.

20.

21.
22.

second). Lower the Beacon Interval to improve tmgssion performance in
unstable environment or for roaming clients, butilt be power consuming.
AMPDU Aggregation: Enables or disables Tx AMPDU aggregation for the
entire interface. Receiving aggregate frames will be performed, but no
aggregate frames will be transmitted if this isatlied.

VHT AMPDU Aggregation: Set VHT capability field, Maximum A-MPDU
length exponent. Value range is 0 to 7. Maximum RDU length exponent
indicates the maximum length of A-MPDU that theistacan receive.

DCS Enable Enable or disable DCS function which is a featioredetect and
avoid CW interference.

Radio Resource ManagementEnables or disables 802.11k

When doneglick Apply

2.4.1.3.5 Guest

The Guest network can temporarily provide 2.4GHd &GHz network connections.

Guests can connect to your specific network nan®and won't connect to your

private network.
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Basic Advanced

Network
WAN
LAN
Wireless
(12173
Parental Control
Multicast

Routing
Services
Security
Qos
Admin
Tools

Status

Wizard

Netwark > Wireless > Guest

Basic WPS ACL Professional Radi{)

2.4GHz

Enable Guest

SSID

Authentication Method
WPA Encryption

Network Key

5GHz

Enable Guest

SSID

Authentication Method
WPA Encryption

Network Key

Steps to seBuestmodule:

N oo g bk w DN P

When done, cliclapply.
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®@ves ONo

WPAZ2 Personal
AES

@ves OnNo

WPA2 Personal
AES 5

Apply

From the navigation panel, goAalvanced > Network > Wireless > Guest
Enable Guest Enable/disable the guest SSID.

SSID: Name of the Guest wireless network.

Authentication Method: Choose way to exchange authentication data.
WPA Encryption: Choose the encrypting method.

Network Key: Key used to encrypt the authentication data.



2.4.1.4IPv6

The module is used to set some basic functiongerkta IPv6. For IPv6 service is not

yet widely available, contact your ISP to make suhether IPv6 service is provided.

Basic Advanced Wizard

Network = IPv6

Network v
VAN Basic
LAN
Connection Type Mative -
Wireless
IPvE
Parental Control IPv6 WAN Settlng
SN WAN IPv6 MTU 1500
Routing User Class Option charter_map
Services p
Security > IPv6 LAN Setting
Qos ’ Enable LAN @ Enable O Disable
Admin > Simultaneous @ Enable O Disable
Tools s LAN IPv6 Address
LAN Prefix Length 64
Status > ¢

LAN IPv6 Prefix
Enable Pool Setting For Lan Host @ Enable O Disable

DHCP Pool Start |
DHCP Pool End 1000
LAN IPv6 MTU 1500

IPv6 DNS Setting

Connect to DNS Server Automati.. @ Yes O No

Port Ranges Valid for Port Forwarding

MapT functicn is enabkle,but nc port range for port forwarding!

Steps to set up IPV6:
1. From the navigation panel, goAalvanced > Network > IPvG
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2. Connection Type Select IPv6 connection type to configure Disali&tive,

Static IPv6.

DHCP-PD: Dhcpv6 prefix delegation.

WAN IPv6 Address: Set the wan interface’s ipv6 address.
WAN Prefix Length: Set the wan interface’s ipv6 prefix length.
WAN IPv6 Gateway. Set the wan interface’s ipv6 gateway

WAN IPv6 MTU : Set the WAN interface’s IPv6é MTU (Maximum Transsion

N oo,k w

Unit).
8. User Class Option The user class option (15) of ORO that DHCPvértk send

to the DHCPV6 server by solicit message.

9. Auto Configuration: The wan interface’s address assign type (SLAADgble:
WAN interface can get ipv6 address by SLAATisable WAN interface gets the
ipv6 address only by stateful.

10.Enable LAN: Enable/Disable router allocating IPv6 addresses lan-side
devices.

11.Simultaneous The mode which hosts connected to the LAN interfeae get
IPv6 addresses. When enabled, hosts get IPv6 addyesimultaneous Stateless
and/or Stateful (requires DHCP pool start and esdes). When disabled, hosts
do not get IPv6 addresses simultaneously by Ststeled/or Stateful, and a mode
must be selected instead.

12.LAN IPv6 Address: Set LAN interface’s IPv6 address.

13.LAN Prefix Length: Set LAN interface’s IPv6 prefix length.

14.LAN IPv6 Prefix: Set LAN interface’s prefix.

15.Enable Pool Setting For Lan Host Enable/Disable allocating ranged IPv6
addresses for lan-side devices.

16.DHCP Pool Start DHCPv6 address setting address pool start.

17.DHCP Pool End DHCPv6 address setting address pool end.

18.PD-Valid Lifetime: Prefix delegation for valid lifetime.

19.PD-Preferred Lifetime: Prefix delegation for preferred lifetime.

20.LAN IPv6 MTU: Set MTU for lan-side devices.

21.Connect to DNS Server Automatically Choose to get the DNS from manually

from uplink.
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22.1Pv6 DNS Server 1 IPv6 address for DNS server.

23.1Pv6 DNS Server 2 IPv6 address for DNS server.

24.1Pv6 DNS Server 31Pv6 address for DNS server.

25.Port Ranges Valid for Port Forwarding: The "port ranges" are set by Map-T
mode, and the port setting for port forwarding mhesin these ranges.

26.Click Apply.
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2.4.1.7 Parental Control

Refer t02.3.5 Parental Controlfor relevant setting descriptions.

2.4.1.8 Multicast

Enable multicast. The sender and receiver achigard to multipoint connection.

Basic Advanced Wizard

Network > Multicast

Network v
UL Multicast
LA amn
IPv4 Multicast Route IGMP Proxy 9
Wireless
16 IPv6 Multicast Route MLD Proxy
Purerial Control Enable IGMP/MLD Snooping ®Yes ONo
Mutticast
Redting
Services >
Security
Qos >
Admin
Tools >

Status

Steps to set up Multicast:

1. From the navigation panel, goAalvanced > Network > Multicast.

2. IPv4 Multicast Route: Select an IPv4 Multicast Route.
*IGMP Proxy: IGMP Proxy enables hosts in a unidii@tal link routing (UDLR)
environment that are not directly connected to ardtream router to join a
multicast group sourced from an upstream network.
*PIM: PIM-Source-specific multicast (SSM) is usediPv4/IPv6 and is a method
of delivering multicast packets in which the onlgckets that are delivered to a
receiver are those originating from a specific seuaddress requested by the
receiver. By limiting the source, SSM reduces deisaon the network and

improves security.
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3. IPv6 Multicast Route: Select an IPv6 Multicast Route.
*MLD Proxy: The MLD proxy is used in IPv6 environmis. This feature enables
a device to learn proxy group membership informmgtiand forward multicast
packets based upon that information. If a devicacting as RP for route proxy
entries, MLD membership reports for these entrias be generated on user
specified proxy interface.

4. Enable IGMP/MLD Snooping: Check [Yegd to enable snooping and Ched¥(]
to disable snooping. IGMP/MLD snooping is the psxcef listening to Internet
Group Management Protocol (IGMP) / Multicast ListerDiscovery (MLD)
network traffic. The feature allows a network swit¢o listen in on the
IGMP/MLD conversation between hosts and routers. IBjening to these
conversations the switch maintains a map of whigkslneed which IP multicast
streams. Multicasts may be filtered from the limdsich do not need them and
thus controls which ports receive specific multidesffic.

5. When done, clickpply.
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2.4.1.9 Routing

This module can be used to build a static NAT tdidaveen WAN IP address and
LAN IP address.

Basic Advanced Wizard

Network = Routing

Network v
R Basic
(@ HELP |
LAN
Enable 1:1 NAT @® Yes O No
Wireless
IPv6 . .
1:1 NAT List (Maximum: 13)
Parental Control
Multicast Name Public IP Local IP On/Off  Operation
Routing - z on 2 [+
Sevices >

Steps to set up Routing:

1. From the navigation panel, goAalvanced> Network > Routing.

2. Enable 1:1 NAT: Check [red to enable this function, checki] to disable this
function.

3. Name A brief description for application.

4. Public IP: IP address from Charter supplied public IP sufinet

5. Local IP: Key in the client's LAN IP address, not limited the subnefor the
directly connected LAN interface

6. Click On/Off to enable/disable Internet access to FTP service.

7. Click ' to add this item to the 1:1 NAT List.
8. Click Apply.

NOTE: This module only works only when WAN port is itasc mode!
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2.4.2 Services

2.4.2.1 USB Printer sharing

Refer t02.3.6.1 USB Printer sharingfor relevant setting descriptions.

2.4.2.2 FTP Server

FTP Server enables an FTP server to share files B88B disk to other devices via

your local area network or via the Internet.

Basic Advanced Wizard

Semvices = FTP Server

Network >
USB Printer Sharing SanDick. Extieme
FTP Server
Samba FTP
WebDAV
Enable FTP
AFD Maximum number of Connections 20
NES Enable Outside Access ®Yes ONo
Outside Access 8021
Security >
Qos >
Admin ?
Device and Folder & J Userand Penmission +N-X
Tools > : :
& Generic_UDISK Anonymous Login m
uuuy
Status > LY User List RW R No
i~ SanDisk_Extreme 4 admin o 0 ®
# UNTITLED
A c © ©
= MOV
m System Volume Information
= SockeiTool2

To set up FTP Server:

9. From the navigation panel, goAalvanced> Services> FTP Server.

10.Connect an externd)SB hard disk drive or USB flash drive to the routand
your device will be displayed here.

11. Click On/Off to enable/disable Internet access to FTP service.
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To create a new account:

1. Add new account.

2.

In the Account and Password fields, key in the name password of your
network client. Retype the password to confirm.ciClAdd to add the

account to the list.

To add a folder:

1. Add new folder.

2. Enter a folder name. The folder that you creatdt lvei added to the folder

list.

To set up permissions on the folder for FTP server:

1. From the list of folders, choose one of the shdotdkrs and select the type

of access permission that you want to assign fecifip users:
* R/W: Select this option to assign read/write access.
* R: Select this option to assign read-only access.

* No: Select this option if you do not want to shaspacific file folder.

2. Click Save Permission to apply the changes.

Refer to the following descriptions:

Maximum number of Connections The maximum number of concurrent
connections for the Network Neighborhood or FTR/8er

Enable Outside Access Select On/Off to enable/disable to access FTP
server by wide area network.

Outside AccessThe numbers of external service ports (defaulieza8021).
Anonymous Login: Enable/disable anonymous access to the FTP server
Safely Remove Disk Click to safely remove diskWVhen the USB disk is
ejected successfully, the USB status shows “Noc@évi

Click Save Permission
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2.4.2.3 Samba

Samba Share allows you to set up the accounts andigsions for the Samba

service.

Basic Advanced Wizard

Semvices = Samba

Network >
Services o Generic_UDISK —
USB Printer Sharing SanDisk_Extreme
FTP Server
e Samba
WebDAV
B Enable Share m
AFP Device Name RT4230W
s Work Group Workgroup
seauty >
Qos >
; Device and Folder @ # Userand Permission [+ X-¥
" ’ |Generic_UDISK Guest Login [ or |
Tools > s UUU User List RW R No
Status s ! saf?_j;:T::;;me & admin o ©0 @
o A test ® O O
&= System Volume In

= SockeiTool2 SocketTool2

To set up Samba:
1. From the navigation panel, goAalvanced> Services> Samba Server
2. Connect an extern&SB hard disk drive or USB flash drive to the router,
and your device will be displayed here.
3. Click On/Off to enable/disable Internet access to Samba service
To create a new account:
1. Add new account.
2. In the Account and Password fields, key in the nam@ password of your
network client. Retype the password to confirm.clAdd to add the
account to the list.

To add a folder:
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1. Add new folder.
2. Enter a folder name. The folder that you createlt lvei added to the folder
list.
To set up permissions on the folder for Samba serve
1. From the list of folders, choose one of the shdoddiers and add the share
name, and choose the type of access permissiotydbaivant to assign for
specific users:
* R/W: Select this option to assign read/write access.
* R: Select this option to assign read-only access.
* No: Select this option if you do not want to shaspacific file folder.
2. Click Save Permission to apply the changes.
Refer to the following descriptions:

* Device Name Enter a name for your device and you can usertise in your
web browser's URL field to quickly access the devas a Network Place
service.

* Work Group : Group name of the cascade in Network Neighborhood

* Note: The standard input characters include letterZ (&-z), digits (0-9). The
hyphen (-) and under line () characters may atsoded, but not as the first
character.

* Guest Login By enabling Guest Login], any user in your local network can
access your network place (Samba) without authesidic.

» Safely Remove Disk Click to safely remove the disk. When the USB dsk
ejected successfully, the USB status shows 'Nacdévi

¢ Click Save Permission
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2.4.2.4 WebDAV

The client can write operation in WebDAV directavith appropriate permissions.

Basic Advanced Wizard

Senvices > WebDAV

Network >
USB Printer Sharing SanDisk Extreme
FTP Sewer
s WebDAV
WebDAV
Enable WebDAV On
e [ on |
izt Enable Outside Access @Yes ONo
NFS QOutside Access HTTP 8080
Cutside Access HTTPS 8443
Security ?
Qos >
i »
Admin Device and Folder © # Userand Permission +N-¥J
Tools 2 (-1 Generic_UDISK RW R Anonymous Login[ ]
Juu ® @
Status > ¢ k'_Ul' User List
SanDisk_Extreme ‘aumin D
# UNTITLED
v
= & test |
= SocketTool2 SocketTool2
To set up WebDAV:

1. From the navigation panel, goAalvanced> Services> WebDAV Server.

2. Connect an external USB hard disk drive or USBHhfldgve to your router,
and your device will be displayed here.

3. Click On/Off to enable/disable Internet access via WebDAV.

To create a new account:

1. Add new account.

2. In the Account and Password fields, key in the nam@ password of your
network client. Retype the password to confirm.ciCliAdd to add the
account to the list.

To add a folder:
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1.
2.

Add new folder.
Enter a folder name. The folder that you creatdtlve added to the folder

list.

To set up permissions on the folder for WebDAV serv

1.

2.

From the list of folders, choose one of the shdoddkers and add the share
name, then choose the type of access permissibrlyabavant to assign for
specific users:

* R/W: Select this option to assign read/write access.

* R: Select this option to assign read-only access.

Click Save Permission to apply the changes.

Refer to the following for the descriptions of tineds:

Enable Outside AccessSelectOn/Off to enable/ disable access to WebDAV
server by WAN (wide area network).

Outside AccessThe port number of external service ports via RTdefault
value: 8080).

Outside Access HTTPS The port number of external service ports via
HTTPS (default value: 8443).

Safely Remove DiskClick to safely remove the disk. When the USB dssk
ejected successfully, the USB status shows 'Nacdévi

Click Save Permission
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2.4.2.5 DLNA

DLNA (Digital Living Network Alliance) allows youd share audio, image and video.
Your router allows DLNA-supported devices to acaasstimedia files from the USB

disk connected to your router.

Basic Advanced Wizard
Services = DLNA

Network >
Services v Generic_UDISK
USB Printer Sharing SanDisk_Extreme
FTP Server
Samba D L NA
WebDAY
A Enable DLNA Media Server “
AFP Media Server Name OpenWrt DLNA Server
o : isks S
NFS Media Server Path Setfting O All Disks Shared
@ Manual Media Server Path
Security >
Qos > Manual Media Server Path (Maximum: 10)
Admin > Media Server Directory Shared Content Type Add / Delete
Tools > Please Select [:]Audiu D Image D Video (+]
Status > /mnUNTITLED/SocketTool2 Audio Image Video (-]

To set up DLNA:

1. From the navigation panel, goAalvanced> Services> DLNA Server.

2. Enable DLNA Media Server. Switch DLNA media on or off.

3. Media Server Name The DLNA server's name, which will be displayed b
the media player, such as VLC or windows mediagilay

4. Media Server Path Setting The methods of setting the folders' path which
will be shared. There are two methods to be cH@depPisks Shared' means
share all of the mounted disks' all medidjahual Media Server Path'
means set the folders to be shared manually, Whanu® is selected you
must enter additional information ifMlanual Media Server Path'.

5. Manual Media Server Path Set the folders to be shared and the media type
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that will be shared by the DLNA server.

6. Media Server Directory: The folders that will be shared by the DLNA.

7. Shared Content Type The media type that will be shared by the DLNA

server: audio, image, video.

8. Safely Remove DiskClick to safely remove the disk. When the USB dssk

ejected successfully, the USB status shows 'Nacdéevi

9. Click Apply.

2.4.2.6 AFP

An AFP server is a kind of network file sharing \&ar based on AFP protocol

implementation, mainly used for file sharing betwééux and MAC systems.

Basic Advanced Wizard

Sevices = AFP

Network >
Sevices ¥ Genere_DiSK -
| gt
USB Piinter Sharing SanDisk: Exireme
FTP Server
Samba AFP
WebDAY
Enable Share
e e _on |
AFP
NES Device and Folder & # Userand Pemmission +N-¥ 4
= Generic_UDISK Guest Login
Security > « LUUU = m
o User List RW R No
Qos > ) SanDisk_Extreme ‘. admin o 0 ®
® UNTITLED
Admin > dac A © © ©
Tools > m System Volume In..
i . = SocketTool2 SocketTool2
atus
m= 09. MicroSIP
To set up AFP:

1. From the navigation panel, goAalvanced> Services> AFP Server.

2. Connect an external USB hard disk drive or USBHhfldsve to your router,

and your device will be displayed here.

3. Click theOn/Off to enable/disable Internet access via AFP.

To create a new account:
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1. Add new account.

2. In the Account and Password fields, key in the name password of your
network client. Retype the password to confirm.cKliAdd to add the
account to the list.

To add a folder:

1. Add new folder.

2. Enter a folder name. The folder that you creatdt lvei added to the folder
list.

To set up permissions on the folder for AFP server:

1. From the list of folders, choose one of the shdodder and add the share
name, and choose the type of access permissiolydhalvant to assign for
specific users:

* RW: Select this option to assign read/write access.

* R: Select this option to assign read-only access.

* No: Select this option if you do not want to sharepac#ic file
folder.

2. Click Save Permission to apply the changes.

Refer to the following for the descriptions of tieds:

* Guest Login By enabling (Guest Login|, any user in your local network
can access your network place (AFP) without autbation.

» Safely Remove DiskClick to safely remove the disk. When the USB dssk
ejected successfully, the USB status shows 'Nacdévi

e Click Save Permission.
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2.4.2.7 NFS

Network File System Server is used to share the diSB with clients via network.
Clients can mount the remote disk to a local dowcfor a faster speed than using a

Samba server.

Basic Advanced Wizard

Services = NFS

Network
Services v Generic_UDISK 0 HELP
USB Printer Sharing SanDisk_Extreme
FTP Server
Samba N FS
\WebDAY
- Enable NFS
AFD Generic_UDISK
o i Clients: | 192.168.1.46 w
- (i SanDisk_Extreme
Security > @UNTIILED
acs

To setup NFS:

1. From the navigation panel, goAalvanced> Services> NFS Server

2. Connect an external USB hard disk drive or USBHhfldgve to your router,
and your device will be displayed here.

3. Enable NFS Enable or disable NFS service. When disabledrsusan't
access the USB storage via the NFS service.

4. Clients: "Clients" are users who can access the sharddigrarspecified.
You can input the proper information into the infietd to allow the clients
to access the specified shared partition. The prppemission format is "IP
address, Read and write permission” and if you warget more than one
clients and with different permission, you can ingne information separated

by ";". For read and write permissions, "ro" medread only" permission

and the "rw" means " read and write" permissione TR address can be
replaced by "*" and means all IPs. For example,

1) Allows the clients with the IP address 192.168tb.Access the partition
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with "read and write" permission.

2) Allows two clients to access the shared partitibhe client with 1P
address 192.168.1.2 has "read only" permission,tlaactlient with IP
address 192.168.1.3 has ‘"read and write" permission
192.168.1.2,r0;192.168.1.3,rw

3) Allows all clients to access the destination shauadition with the "read
only" permission. > *;ro

5. Safely Remove DiskClick to safely remove the disk. When the USBdss

ejected successfully, the USB status shows 'Nacdévi

2.4.3 Security

2.4.3.1 VPN

VPN (Virtual Private Network) provides a secure ooumication to a remote

computer or remote network using a public netwaighsas the Internet.

2.4.3.1.1 PPTP VPN Server

The VPN server allows administrator to get accesshdme network anytime,

anywhere.

Basic Advanced Wizard

Security > VPN > PPTP VPN Server

Network >
Services > OpenVPN Server VPN Client
Security v
VPN Basic Config
AR Enable VPN Server m
e emol VPN Details General
Qos >
Admin s Username and Password (Maximum: 16)
Tools 2 Connection Status Usermname Password Add / Delete
Status > o
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NOTE: Before setting up a VPN connection, you needhaddress or domain name

of the VPN server you are trying to access.

Steps to set up access to PPTP VPN server:

1. From the navigation panel, go fadvanced > Security > VPN > PPTP VPN

Server.

Enable VPN Server enable or disable PPTP VPN Server.
VPN Details: The details of PPTP VPN Server. Select Generdldwanced

settings.

Username and PasswordThe user information of PPTP VPN Server. Input

the user name and password for the VPN serverlatkdtiee = button.

2. Advanced VPN server settings, as below.

Advanced Settings

Broadcast Support ® Yes Mo

When Network Place is enabled, this must be enabled

Authorization Mode Auto

MPPE Encryption m MPPE-128

m MPPE-40

m No Encryption

Connect to DNS Server Automatic... ®ves O Mo

Connect to WINS Server Automatic... ® ves O Mo

MRU 1462
MTU 1462
Client IP Address 19216802 ~182.168.0. | 11 | (Maximum:10)

Broadcast Support Turns on broadcast relay to clients from the eout
Authorization Mode: Select Authorization Mode.

MPPE Encryption: Select MPPE Encryption type.

Connect to DNS Server Automatically:DNS of PPTP clients.
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e Connect to WINS Server Automatically WINS of PPTP clients.

* MRU/MTU: The Maximum Receive Unit (MRU) or Maximum
Transmission Unit (MTU) sizes are sent to the ¢lias part of the PPTP
parameters to use during the PPTP session. We mendcthat you do not
change MTU or MRU values unless you are sure thengh corrects a
known problem with your PPTP sessions. IncorrectUMF MRU values
cause traffic through the PPTP VPN to fall.

* Client IP Address: The IP address range of PPTP clients.

* Click Apply.
2.4.3.1.2 OpenVPN Server

The VPN server allows administrator to get accesshdme network anytime,

anywhere.
Basic Advanced Wizard
Security = VPN > OpenVPN Server
Network >
Services > PPTP VPN Server JelCiz R @ VPN Client
Security v
Update succeeded !

VPN

IPv4 Firewall Basic Config

IPv6 Firewall

Enable VPN Server m
Qos > VPN Details General
Admin >
Tools > Username and Password (Maximum: 16)
Status 2 Connection Status Username Password Add / Delete
]

Steps to set OpenVPN Server:
1. From the navigation panel, go Aglvanced > Security > VPN > OpenVPN
Server.
* Enable VPN Server Enable or disable OpenVPN server function.
* VPN Details Enter the details of your VPN server. Select Ganer
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Advanced settings.
* Username and PasswordThe user information of OpenVPN server. Input
the user name and password for the VPN serverlatkdtise = button.

2. Advanced VPN server settings:

Advanced Settings

Interface Type TUN -
Protocol UDFP z
Server Port 1194

Firewall Auto -
Authorization Mode TLS z

Content Modification of Keys & Cerification.

Username / Password Auth. Only OYes @ No
Extra HMAC Authorization Disable o
VPN Subnet / Subnet Mask 10.8.0.0

2552552550

Poll Interval 0 Minutes

Push LAN to Clients OYes @ No

All traffic through VPN O Yes @ No

Respond to DNS O Yes @ No

Encryption Cipher Default -
Compression Disable z
TLS Renegotiation Time 0 Seconds
Manage Client-Specific Options OYes @ No

* Interface Type: "TUN" will create a routed IP tunnelTAP" will create an
Ethernet tunnel.

* Protocol: TCP or UDP server.

* Server Port The TCP/UDP port which OpenVPN server will listam

* Firewall: Firewall configuration for VPN serveAuto will create complete
firewall configurations, External only will create basic firewall
configurations an€ustom will not create any firewall configurations.

e Authorization Mode: SelectAuthorization Mode.
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Username / Password Auth. Only Yes requires only username and
password for authenticatioNo also requires authentication certificate.
Extra HMAC Authorization : If enabled, a tls_auth key will be used on the
server. Every client must also have the key.

VPN Subnet / Subnet MaskVPN subnet and subnet mask settings.

Poll Interval : The interval time for crontab of VPN server dtagt

Push LAN to Clients Push routes to the client to allow it to reacheot
private subnets behind the server.

All traffic through VPN : If enabled, this directive will configure all elits
to redirect their default network gateway througle VPN, causing all IP
traffic such as web browsing and DNS lookups tahgough the VPN.
Respond to DNS Push DNS to clients.

Encryption Cipher: Select a cryptographic method. This configurenite
must be copied to the client configure file as well

Compression Enable compression on the VPN link. If this fuoot is
enable here, in the client configure administraiso should enable it.

TLS Renegotiation Time After a period of time, authentication is reqdire
again.

Manage Client-Specific Options To assign specific IP addresses to specific
clients or if a connecting client has a privatersitbehind it that should also
have VPN access, enable this option.

Click Apply.
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2.4.3.1.3 VPN Client

View the VPN server list and add profiles. There three types of VPN servers:

PPTP, L2TP and OpenVPN.

Basic Advanced Wizard

Security = VPN > VPN Client

Network >
Services > PPTP VPN Server = OpenVPN Server RYNEellEH
. (@ HELP|
Security v
VPN VPN Server List (Maximum: 8)
IEvE Einewall Connection Status Description VPN Type Edit  Delete Connection

IPv6 Firewall

Add Profile

Steps to setup a VPN Client:
1. From the navigation panel, goAavanced > Security > VPN > VPN Client
2. VPN Sever list is displayed. Cligkdd Profile to set up VPN Client.

VPN Client

VPN Type PPTP a
Enable Default Route OYes @ No

Description

VPN Server
Username
Password

PPTP Options Auto -

3. VPN Server List: Current VPN Services which have been configured.

4. VPN Type: Type of VPN Server access such as PPTP, L2TRDaedVPN.

5. Enable Default Route Check [feg to use default route acquiring from VPN
Server. CheckNo] to use general default route.

6. Description: Enter a description for reference.

85



10.

11.

VPN Server. VPN Server IP address or URL.

Username VPN authentication username.

Password VPN authentication password.

PPTP Options PPTP Encryption method. Select Auto for automiticrosoft
Point-to-Point Encryption (MPPE) and select No BEption to disable MPPE.
Select MPPE 40 for 40-bit MPPE with PPTP Server seléct MPPE 128 for
128-bit MPPE with PPTP Server.

When done, cliclConfirm.
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2.4.3.2 IPv4 Firewall

Enable the firewall to protect local area netwagkiast attacks from outside. Firewall

filters the incoming and outgoing packets basedutes.

NOTE: Firewall is enable by default.

2.4.3.2.1 Common

Basic Advanced Wizard

Security > IPv4 Firewall > Common

Network >
Services > Net Service Filter | Client ACL
Security v
VPN H
Basic
IPv4 Firewail
Firew Ye Is}
iPvé Firowall Enable Firewall @Yves ON
Enable DoS Protection ®ves ONo
Qos >
Respond to Ping Request fromW... OYes @ No
fdiin : Enable IGMP @Yes OMNo
Tools >
Status > L ey

Steps to set up basic Firewall settings:
1. From the navigation panel, go tddvanced > Security > IPv4 Firewall >
Common.

2. Enable Firewall: Disabling the firewall will deactivate all relatéunctions.

Enable DoS Protection A "denial-of-service" attack is an explicit attpimnto
deny legitimate users from using a service or cdempresource. Enabling this
feature can protect the router from DoS attackibwtould increase the router's
workload.

Respond to Ping Request from WAN This feature allows router to make a
response to ping request from WAN.

Enable IGMP: Check [Yes] to allow IGMP packages to be transi@rto the
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router. Check No to deny IGMP packages.
6. Click Apply.

2.4.3.2.2 Net Service Filter

Under the help of this module, administrator can tdack list to block certain

services, or set white list to let some servicgsa®s through the router.

Basic Advanced Wizard

Security > IPv4 Firewall > Net Service Filter

Network >
Services > Common MNEEEVEAREE Client ACL
Security v
i Net Service Filter
IPv4 Firewall
Enable Net Service Filter O Yes ® No
|BvE Firewall
Filter Table List White List
»
feat Filtered ICMP packet types
Admin >
Tools Network Services Filter Table (Maximum: 32)
Status » Source IP Port Range Destination IP Port Range Protocol éqggt_.fe
TCP 4]

Apply

Steps to sdllet Service Filter|g

1. From the navigation panel, go #advanced> Security> IPv4 Firewall> Net
Service Filter.

2. Enable Net Service Filter Enable or disable this module.

3. Filter Table List: There are two kinds of filter list: White List)d&k List. White
List can make router serve the specified servidenel@ in the list, Black List
make router deny serving the specified service.

4. Filtered ICMP packet types This field defines a list of LAN to WAN ICMP
packets type that will be filtered. For exampleyau would like to filter Echo
(type 8) and Echo Reply (type 0) ICMP packets, geed to enter a string with
numbers separated by blank, such as [0 8].

5. Source IP. For source or destination IP address, you cgrerfter a specific IP
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9.

address such as "192.168.122.1"; (b) enter IP adésewithin one subnet or
within the same IP pool such as "192.168.123.*"1®2.168.*.*"; or (c) enter all
IP addresses as "*.*.*.*".

Port Range For source or destination port range, you caheeita) enter a
specific port, such as "95"; or b) enter ports with range such as "103:315",
">100", or "<65535".

Destination IP: For source or destination IP address, you carer{ger a specific
IP address such as "192.168.122.1"; (b) enter &#Peades within one subnet or
within the same IP pool such as "192.168.123.*"1®2.168.*.*"; or (c) enter all
IP addresses as "*.*.*.*".

Port Range For source or destination port range, you caheeita) enter a
specific port, such as "95"; or b) enter ports wita range, such as "103:315",
">100", or "<65535".

Protocol: The protocol of service used to transport thekpges. (UDP, TCP)

10. Add/Delete: Click or to add/delete the profile.

11. When done, cliclipply.

89



2.4.3.2.3 Client ACL

This module is used by administrator to preventeotrom routing packets which are

from specified lan-side devices.

Basic Advanced Wizard

Security > IPv4 Firewall = Client ACL

Network >
Services > Common = Net Service Filter
: @ HELP|

Security v

VPN Basic

IPv4 Firewall

Y — Enable Client ACL @Yes ONo
Qos > . . .

_ Client ACL List (Maximum: 16)
Admin >
Client Add/Delete
Tools >
z G

Status >

Steps to set uglient ACL ‘&

1. From the navigation panel, go Aalvanced> Security> IPv4 Firewall> Client
ACL.

Enable Client ACL: Enable or disabl€lient ACL function.

Client: MAC address of lan-side devices.

Add/Delete: Click or @ to add/delete the profile.

a M 0D

When done, cliclApply.
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2.4.3.3 IPv6 Firewall

2.4.3.3.1 Common

Basic Advanced Wizard

Security > IPv6 Firewall > Common

Network >
Services > IPV6 Firewall
.
Security v
VPN H
Basic
IPv4 Firewall
- Enable Firewall @Yes ONo
IPv6 Firewall
Respond to Ping Request fromW... ®Yes O No
Qos >
Enable MLD ®ves ONo
Admin >
Toos ;
Status >

Steps to set up commadve Firewall:

1. From the navigation panel, go t#&dvanced > Security >IPv6 Firewall >
Common.

2. Enable Firewall: Disabling the firewall will deactivate all relatdunctions.

3. Respond to Ping Request from WAN This feature allows router to make a
response to ping request from WAN.

4. Enable MLD: Check Jred to allow MLD packages to be transferred to thateo
Check No] to deny MLD packages.

5. Click Apply.
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2.4.3.3.1 IPv6 Firewall

All outbound traffic coming from lan-side IPv6 hest allowed, as well as related
inbound traffic. Any other inbound traffic must bpecifically allowed here. You can

leave the remote IP empty to allow traffic from aeynote host. A subnet can also be
specified.

Basic Advanced Wizard

Security = |Pv6 Firewall > IPv6 Firewall

Network >
Services > Common
Security v
S Basic
IPv4 Firewall
. Enable Service Firewall OYes @ No
IPvE Firewall
Allowed Well-Known Server List Please select
Qos
Admin > Allowed Service Rules (Maximum: 32)
Tools 2 Service Name Remote IP/CIDR Local IP Rzgge Protocol S;gtg
Status > TCP ¢ [E]
Allowed ICMPv6 Rules (Maximum: 16)
ICMPVE Message type Local Host Add / Delete
destination-unreachable 5 [+

Steps to set upPv6 Firewall:

1. From the navigation panel, go Amlvanced > Security > IPv6 Firewall > IPv6
Firewall .

2. Enable Service Firewall Enable or disable the IPv6 firewall. When disdblall
IPv6 packages can input router, output router angdrd without any limitation.

3. Allowed Well-Known Server List: List of well-known servers to be allowed.
For example: ftp, samba.

4. Service Name The name of the service which will add IPv6 firelvale.

5. Remote IP/CIDR: IPv6 address of a remote server.

6. Local IP: IPv6 address of a lan-side client.
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7. Port Range Port range accepts various formats such as PargéR (300:350),
individual ports (566,789) or Mix (1015:1024, 3021)

8. Protocol: The protocol the service uses to transport the ggek e.g. (UDP,
TCP).

9. ICMPv6 Message Type Make router process the defined types of ICMPVv6
packet from specified host.

10. Local Host: IPv6 address of the host.

11. Add/Delete: Click or @ to add/delete the profile.

12. When done, cliclipply.

2.4.4 QoS

QoS(Quality of Service, QoS) module provides défdrservices according to the

priority of applications, users, or data flows.almvord, it can guarantee a certain level

of performance to a data flow.

2.4.4.1 Prio Mark

2.4.4.1.1 SSID

This module can equip the router with the ability grovide QoS service to the

wireless connections.

Basic Advanced Wizard

Qos > Prio Mark > SSID

Network >
Services > m Server  Client Application
Security >
Qos 3 SSID Mark List (Maximum: 16)
Pric
o ssiD DSCP Value WMM Add/Delete
Speed Limit
MySpectrumWiFi50-2G 2 -- S| = 2 [+ ]
Aijrtime Fairness
Admin >
Tools >
Status >

Steps to set up:
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A w0 NP

o

From the navigation panel, go@pS> Prio Mark > SSID.
SSID: Choose the name of t Wi-Fi which is going to pdevQoS service.
DSCP Value lts value is used to indicate the priority folagding data.

WMM : Its value is used to indicate the priority fomddoading data.

Click to add this item to the SSID Mark List.

Click Apply.
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2.4.4.1.2 Server

For different remote servers, this setting can tlet connections get different

priorities.

Qos > Prio Mark > Server

> Netwark
> Services SSID m Client Application
@ HELP|

> Security
v Qos Server Mark List (Maximum: 16)

L Server IP DSCP Valie Add/Delete

Speed Limit

AF13(001110) 5 [+]

Ajrtime Fairness

> Admin

Stepstosetup:
1. From the navigation panel, go@oS> Prio Mark > Server.
2. Server IP: IP address of remote server.
3. DSCP Value It's value is used to indicate priority of contiens to the

responding server.

4. Click L+ to add this item to the Server Mark List.

5. Click Apply.
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2.4.4.1.3 Client

Qos > Prio Mark > Client

> Network
> Services SSID | Server Application
@ HELP

> Security
v Qos Client Mark List (Maximum: 16)

i Client DSCP Value Add/Delete

Speed Limit o

Airtime Fairness -
> Admin

Steps to set up :
1. From the navigation panel, go@»S> Prio Mark > Client.
2. Client: MAC address of the lan side device.
3. DSCP Value It’'s value is used to indicate priority of contiens to the

lan-side device.

4, Click ] to add this item to the Server Mark List.
5. Click Apply.
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2.4.4.1.4 Application

Qos > Prio Mark > Application

> Network
> Services SSID  Server Client
@ HELP

> Security
v Qos Application Mark List (Maximum: 16)

Fiio Mark Application DSCP Value Add/Delete

Speed Limit

Access Remote PC [ [ +]

Airtime Fairness

> Admin
Steps to set up :
1. From the navigation panel, go@pS> Prio Mark > Application.
2. Application: The name of application that is going to use QoS.

3. DSCP Value It’'s value is used to indicate priority of apg@itmon.

4. Click o to add this item to the Server Mark List.
5. Click Apply.

2.4.4.2 Speed Limit

This module makes it possible for user to limit thgeed of downloading and

uploading respectivly.

Qos >Speed Limit

> Netwark
> Services Internet Bandwidth Status
O HELP)
> Security Enable Upload Limit OvYes ®No
v Qos Upload Speed Mbps
Prio Mark Enable Download Limit OYes @ No
Speed Limit Download Speed Mbps

Airtime Fairness

> Adioin
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Steps to set uBpeed Limit

1. From the navigation panel, go@oS> Speed Limit

2. Enable Upload Limit: . Check Jreg to enable upload speed limit and Check
[No] to disable upload speed limit.

3. Upload Speed The highest speed that the router can provide data
uploading.

4. Enable Download Limit: Choose the wifi that is going to provide QoS.

5. Download Speed The highest speed that the router can provided&ia
downloading.

6. Click Apply.

NOTE: If speed of uploading or downloading set by ysubeyond actual value

provided by your ISP, your setting will take noeeff

2.4.4

.2 Airtime Fairness

The ATF(Airtime Fairness, ATF) module supports mgirates of WiFi devices to

achieve better performance in busy/intense envissms

Qos = Airtime Fairness

> Network
> Services General
> Security Enable ATF Oves @nNo
v Qos Frequency 2 4GHz
Prio Mark ATF Mode strict-queue
Speed Limit
Artima:Eaire SSID Percentage of Air Time (%)
irime Fairness
. MySpectrumWiFi50-2G 60
> Admin
PO
> Tools
> Status L ey
Steps to set ATF:
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. From the navigation panel, goAalvanced> QoS> Airtime Fairness.

. Enable ATF. Enable or disable. ATF require primarily focusas scheduling
fairness for transmission of traffic from Accessi®qAP), and efficient Wi-Fi
bandwidth utilization.

. Frequency. In the frequencyield, select the frequency band that you wantge u
for the ATF settings.

. ATF mode: Airtime Fairness implements 2 scheduling algonish strict-queue
and fair-queue algorithm, which are mutually exilas Strict-queue algorithm
follows strict airtime allocation as configured bye user and does not try and
utilize any unused bandwidth. Fair-queue algorithboarantees the configured
airtime in congested environments and it alsoagdiany unused bandwidth.

. SSID: Set the SSID which will be controlled by ATF.

. Percentage of Air Time Set the percentage of SSID which will be usedADiF
control.

. MAC: Select client by MAC address and set the peredmth will be used for
ATF control.

. Click Apply
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2.4.5 Admin

2.4.5.1 System

The Systenpage allows you to configure your wireless routstisgs.

Basic Advanced Wizard

Admin > System

Network >
Services > Change the Router Login Password
Security > Username admin
Qos > New Password
Admin v Retype New Password D Show password
System
Configuration SSH Daemon
Log
Enable S5H Access from WAN O Yes ® No
Tools - Enable SSH Access from LAN O Yes ® No
Status >

Miscellaneous

Remote Log Server

Time Zone America/New York o
Auto Logout 0 Minutes(Disable:0)
Enable WAN Down Natification ®Yes ONo

Allow Only Specified IP Address OYes @No

NTP Server (Maximum: 6)

NTP Server Add/Delete
©
us.pool ntp_org (-]
north-america.pool.ntp.org (-]
time.nst.gov (-]
pool.ntp.org (-]

Steps to sebystem
1. From the navigation panel, goAalvanced > Admin > System.
2. Username Router’s login name.

3. New Password New password.
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4. Retype New PasswordRetype new password.

5. Enable SSH Access from WANEnable or disable SSH connection from WAN
port.

6. Enable SSH Access from LAN Enable or disable SSH connection from LAN

port.

NOTE: Three SSH accounts can be used to login the router.
1. Admin: username and password aemin, admin

2. Operator: username and password@perator, operator

3. Root: username and password avet, MmvGBARY 3#

7. Remote Log Server IP address of a syslog server to which log messagll be
sent in addition to the local destination.

8. Time Zone Default time-zone is America/ New York.

9. Enable Web Access from WAN Enable or disable remote access via WAN port.

10. Auto Logout: Auto logout after a specified time.

11. Enable WAN Down Notification: When there is no Internet access, redirect to
local notification.

12. NTP Server. Router can access a NTP (Network Time Protocal)esan order
to synchronize the time automatically.

13. Click Apply.
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2.4.5.2 Configuration

Basic Advanced Wizard

Admin > Configuraticn

Network >
Services > Configuration
O HELF
Security ? Save to File m
Qos > Reset to Default
Admin v Restore from File
System

Configuration

Log
Tools >
Status >

Steps to save/reset/restore router’s configuration:

1.
2.

From the navigation panel, goAalvanced > Admin >Configuration.
Click Save,and then the browser will automatically downloaditen’s setting
files.

Click Reset to Defaultthis will this resets all settings to factory defaulttseys.

Click " to select setting file, the clicklpload button, this will make the

router to be set.
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2.4.5.3 Log

System Log contains logs on network activitieshia touter.

Basic Advanced Wizard

Admin > Log
Network >
System Time Thu Dec 15 21 : 43 : 57 2016
Services >
. Up Time 0D 19H 19M 318
Security >
Qos >
Admin v
System
Configuration wifil
Log USER root pid
}ha U3ER root pid
Tools > b
Thu ]1: USER rocot pid 18279 cmd
Status > /8b

USER rocot pid

05]: USER root pid 18412 cmd
]1: USER root pid 18475 cmd

USER root pid

5] USER roct pid 12608 cmd y

I T

Steps to set router’s log:

1. From the navigation panel, goAalvanced> Admin> Log.
2. Clear: Clear contents in log file.

3. Save Download log file from router.
4

Refresh Refresh the log window to show the latest log.
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2.4.6 Tools

2.4.6.1 Diagnostic Tools
Various diagnostic tools are available such as,pig6, traceroute and nslookup.

Basic Advanced Wizard

Tools = Diagnostic Tools

Network >

Services > Diagnostic Tools

Security 2 Method Ping :
Qos > Target Wikipedia s
Admin > Count 10

Tools v

Diagnostic Tools

Wake on LAN

Status >

3tatistics ---
ckets

round-trip min/

Steps to use Diagnostic Tools:

1. From the navigation panel, goAalvanced> Tools> Diagnostic Tools
2. Method: Choose a specified method to test network.

3. Target: Choose target for the test.

4. Count: Number of times to test.

5. Click Diagnose
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2.4.6.2 Wake on LAN

Wake on LAN is a power management function. Itaimetwork admins to wake up
LAN side devices from standby or hibernation moddis function requires

motherboard support on LAN-side devices.

Basic Advanced Wizard

Toois > Wake on LAN

Network >

Services > Basic

Seauly > e [ vein

Qos >

: \ Offline List Maximum: 32

Admin >

Tools < Device Name MAC Address Add / Delete
Diagnostic Tools ° e
e L ooy

Status >

Steps to set Wake on LAN:

1. From the navigation panel, goAalvanced> Tools> Wake on LAN

2. Target: Enter the MAC address of the device to be wokgnou select the device
name from the list.

3. Device Name Name of device.

4. MAC Address: The format for the MAC address is six groups wofot
hexadecimal digits, separated by colons (:), inndmaission order (e.qg.
12:34:56:aa:bc:ef).

5. When done, clickApply.
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2.4.7 Status

2.4.7.1 System Information

System Information displays basic System, WAN, LAt USB information.

From the navigation panel, goAalvanced > Status > System Information

Basic Advanced Wizard

Status = System Information

Network >
Services > System Information
Security > Up Time 0D 22H 22M 538
QGS > Date Time 2016-12-30 02:43:25
Admin > FW Version 103
Tools 5 HW Version V1.0 REV:2
Status v

System Infermation WAN |nf0rmat|0n

Wireless Connection Status Connected

DHCP Lease Connection Type DHCP

Routing Table Connect IP 10.8.4.218

Port F di =

SRERAICTS Connection Time 0D 22H 21M 538

Connection List

IPvG Information .
Sooping Table LAN Information
CHEERE SR IP (Subnet Mask) 192 168.1.1(255 255 255 0)

Blocked Users DHCP Server On/Off ON

USB Information

Mode| Name Generic UDISK
Total Space 716G
Available Space 52G

106



2.4.7.2 Wireless

Wireless shows status information for wirelessntbe

From the navigation panel, goAalvanced> Status>Wireless.

Basic Advanced Wizard

Siatus > Wireless > 2. 4GHz Clients

Network >
Services > 5GHz Clients
[ © HELH

Security >

Qos 5 Wireless Log

Admin >

Tools >

Status v

System Information

Wireless
DHCP Lease
tations List
Routing Table
Mo staticn connected

Port Forwarding

2.4.7.3 DHCP Lease

Show DHCP Lease status information, including MA@ and Hostname
information.

From the navigation panel, goAalvanced> Status> DHCP Lease.

Basic Advanced Wizard

Status > DHCP Lease

Network >
Services > DHCP Leases
Security > MAC IP Hostname
>
Qos
Admin >
Tools >
Status v

System Information
Wireless

DHCP Lease
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2.4.7 .4 Routing Table

Show IPv4 and IPv6 routing table and status infdiona

From the navigation panel, goAalvanced> Status > Routing Table.

Basic Advanced Wizard

Status = Routing Table
Network >

Services > Routing Table

Kernel IP routing takle -
Genmask Flags Metric Ref T: fa
e 1] a

Security >

Qos >

(S
o
)

Admin >

Tools >

Status v

System Information
Wireless

DHCP Lease
Routing Table

Port Forwarding
Connection List
IPV6 Information
Snooping Table

Current Users

Blocked Users
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2.4.7.5 Port Forwarding

This module is used to show port forwarding statfermation.

From the navigation panel, goAalvanced> Status> Port Forwarding.

Basic Advanced Wizard

Status = Port Forwarding

Network >
Services > Port Forwarding
. @ HELP|

Security > Service Name Port Range Local IP Local Port Protocol

Qos >

Admin >

Tools ?

Status v

System Information
Wireless

DHCP Lease
Routing Table

Port Forwarding
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2.4.7.6 Connection List

Show active connections status information.

From the navigation panel, goAalvanced> Status> Connection List.

Basic Advanced Wizard

Status = Connection List

Network
Services
Security
Qos
Admin
Tools

Status
System Information
Wireless
DHCP Lease
Routing Table
Port Forwarding
Connection List
IPv6 Information
Snooping Table
Cument Users

Blocked Users

v

Active Connections

Network
ipvd
ipvd
ipvd
ipv4
ipvd
ipvd
ipv4
ipvd
ipv4
ipvd
ipvd
ipv4
ipvd

ipvd

Protocol
tcp
tcp
tcp
tcp
tcp
tcp
tcp
tcp
tcp
tcp
tcp
tcp
tcp

tcp

2.4.7.7 IPv6 Information

Status
TIME_WAIT
TIME_WAIT
TIME_WAIT
TIME_WAIT
TIME_WAIT
TIME_WAIT
TIME_WAIT

ESTABLISHED
TIME_WAIT
TIME_WAIT
TIME_WAIT
TIME_WAIT
TIME_WAIT

TIME WAIT

Source

192.168.1.112:59292

192.168.1.112:59275

192.168.1.112:59276

192.168.1.112:59270

192.168.1.112:59291

192.168.1.112:59271

192.168.1.112:59290

192.168.1.112:59293

192.168.1.112:59289

192.168.1.112:59285

192.168.1.112:59288

192.168.1.112:59280

1921681 112:59277

192.168.1.112:59287

Shows details on WAN and LAN IPv6 information.

Destination

192.168.1.1:80

192.168.1.1:80

192.168.1.

192.168.1.

192 1681

192.168.1.

192.168.1.

192.168.1.

192.168.1.

192.168.1.

192.168.1.

192.168.1.

192 1681

192.168.1.

From the navigation panel, goAalvanced> Status> IPv6 Information.
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Basic Advanced Wizard

Status > IPv6 Information

Network >
Services > IPve Network Information
@ HELF
Security > : s i e R
Qos >
Admin >
Tools >
Status v
System Information Z:5%5 1 28RT
Wireless
DHCP Lease

Routing Table
Port Forwarding
Connection List

IPV6 Information

2.4.7.8 Snooping Table

Displays snooping table for client joins/leaves fmth wired and wireless client
streams.

From the navigation panel, goAalvanced> Status> SnoopingTable.

Basic Advanced Wizard

Status = Snooping Table

Network >
Services > Snooping Table
) @ HELF

Security >
Qos > e FOB B

1 34:97:TR:Te:45:RT et
Admin >
Tools >

Bridge Snocping Hash Table —— IBvE

Status v NO¥  GROUE FDB BC

System Information
Wireless

DHCP Lease
Routing Table

Poit Forwarding
Connection List
IPvE Infomnation

Snooping Table
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2.4.7.9 Current Users

Display current user who is permitted to get actedsternet through the router.

From the navigation panel, goAalvanced> Status> Current User Table.

Basic Advanced Wizard

Status > Current Users

Network >

Services > Current Users

Security b Name P MAC Interface
Qos > DESKTOP-J684GS3 192.168.1.112 34:97-F6:TE49:A7 LAN
Admin > <unknown= 192.168.1.40 00:0C:29:30:A9:D0 LAN

Tools > IPVE-BENCH 192.168.1.248 00:0C:29:E6:08:2D LAN
Status v

System Information
Wireless

DHCP Lease
Routing Table

Port Forwarding
Connection List
IPv6 Information
Snooping Table

Cument Users

2.4.7.10 Blocked Users

Display current users who are not permitted to aygtess to Internet through the
router.

From the navigation panel, goAalvanced> Status> Blocked User.
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Basic Advanced Wizard

Status > Blocked Users

Network >

Services > Blocked Users

Security > Frequency MAC Interface
Qos >

Admin >

Tools >

Status v

System Information
Wireless

DHCP Lease
Routing Table

Port Forwarding
Connection List
IPVE Infonmation
Snooping Table
Current Users

Blocked Users

113



3 Root User Settings

You can login to the GUI as a root user for morefiguration options. Root user

settings are hidden and cannot be configured byalousers.

3.1 Login

Root user of the router owns more privilege thamnmNg User. Following shows the
steps to log in Root User’s GUI:
1.0pen a web browser and enter IP address:

http://192.168.1.1/a43edc96b9451f5d3c624838b54183f2dbdb6bel23e5/cab

c40542f5e7c4a59f66ca01028597a/login.html

2.0n the login page, enter the default root usernarnet, and password:
MmvGB"RY3#.

3.Use the Web GUI to configure various hidden seftiofyyour wireless router.

Charter

Spectrum»

Username root

Password = sssssesss -|

3.2 Router

3.2.1 Static Routing

This module allows administrator to add routingesufor the router. This feature can
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be useful when there are several devices who ameecting with router.

Router > Static Routing

Router v

Static Routing Basic

Dynamic Routing (I=E

Enable Static Routes @ves OnNo

Multiple NAT
TR-069 > Static Routing List (Maximum: 32)
Operation Mode  ~ Network/Host IP Subnet Mask Gateway Metric  Interface Add/Delete
Admin > WAN © L+

>

2 e

Steps to set Static Routing:

1.
2.
3.

© © N o

From the navigation panel, goRmot > Router > Static Routing.

Enable Static Routes Select fed to enable static routes.

Network/Host IP: The destination network or host of a route ritlecould be a
host address such as '192.168.123.11' or a netduolless such as '192.168.0.0'".

Subnet Mask Indicates how many bits are for network ID anthreat ID. For
example: if the dotted-decimal Subnet Mask is 255.255.0, then its’ Subnet
Mask bits is 24. If the destination is a hostStdbnet Mask bits should be 32.

Gateway. This is the IP address of the gateway where pgacke routed to. The
specified gateway must be setup and reachable first

Metric : Metric is a value of distance for the network.

Interface: Network interface that the route rule will appdy

Add/Delete: Click or @ to add/delete the profile.

When done, cliclApply.
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3.2.2 Dynamic Routing

Dynamic routing means router can automatically ma@mits routing table. Dynamic
routing has two basic functions: maintain routiaglé, and exchange routing table

with other routers.

Root Wizard

Router = Dynamic Routing

Router v
Static Routing Basic
Dynamic Routing
RIP Key Authentication ®@ves QONo
Multiple NAT
RIP Key Chain
K >
TR-089 RIP Key 0 [ show key
Operation Mode > RIP Key 1 [ show ey
Admin ’ Dynamic NAT IP :
DFS Test Mode  ~
, RIP Block List (Maximum: 3)
Fast Roaming »
Alias RIPIP RIPSubnet RIPDefaultGateway  On/Off  Operation
Coverage »
On ©

Steps to set up Dynamic Routing:

1. From the navigation panel, goRmot > Router > Dynamic Routing.

2. RIP Key Authentication: Enable or disable RIP key authentication mecmanis
when switching route with other routers.

RIP Key Chain: RIP key name.

RIP Key 0: RIP key value of RIP Key 0.

RIP Key 1: RIP key value of RIP Key 0.

o o & w

Dynamic NAT IP: Single IP address from Charter supplied publicsiiBnets
used for all internal hosts traffic flow.

7. Alias: Friendly identifier for managed element

8. RIPIP: IP address to be advertised.

9. RIPSubnet Subnet mask for RIPIP.
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10. RIPDefaultGateway. Gateway IP for RIPIP

11. On/Off: Enable or disable this item rule.

12. When done, clicipply.

3.2.3 Multiple NAT

This can let you limit range of ipaddress thatogg to use NAT function.

Root Wizard

Router = Multiple NAT

Router v

Static Routing Basic

Dynamic Routing GE

Enable Multiple NAT Ovyes @nNo

Multiple NAT
TR-069 > Multiple NAT (Maximum: 32)
Operation Mode > Name Public IP Network/HostIP  SubnetMask  On/Off  Operation
Admin > - z On ¢ 4+

>

OFS Tesode

Steps to saVultiple NAT :

1.
2.

S - o

o

From the navigation panel, goRwot > Router > Multiple NAT.

Enable Multiple NAT: Check [yeq to enable this function, CheckN§] to
disable this function.

Name: The name for the item bar.

Public IP: IP address that Host IP will be mapped to.

Network/Host IP: IP address of the host reside on lan-side.

Subnet Mask The subnet mask for lan-side IP address.

On/Off: Enable or disable the multiple NAT rule.

click @ to add this item to the Multiple NAT List.
Click Apply.
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3.3 TR-069

TR-069 is a technical standard defined by DSL farlis full name is CPE WAN

management protocol. This module can provide argéframework and protocol to

a centralized router from remote Internet for ngemeration network-management

family equipment configuration.

Root Wizard

Router >
TR-069 >
Operation Mode >
Admin >
DFS Test Mode >
Fast Roaming >

Coverage >

Steps to set TR-069:

1. From the navigation panel, goRmot > TR-069.

TR-069

TR-069

Enable Remote Management
ACS Identifier

URL

Username

Password

Periodic Inform Time

Periodic Inform Interval
Periodic Inform Enable
Connection Request Username

Connection Request Password

@ Yes O No
CHARTER .
http://askey.acs.clearaccess.cor
digest
digest
2015-04-28T11:40:00Z2
900

@ Enable O Disable

admin0000000000044
OneAcsToRuleThemAll

Apply

2. Enable Remote ManagementEnable or disable TR-069 remote management.

3. ACS Identifier: Mark the current choice of connecting the ACSvseris

CHARTER or TWC.

4. URL: ACS’s address is defined by an URL. Router(CR#) communicate with

an ACS through an valid URL.

5. Username Username used to authenticate the CPE when makiognection to
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the ACS using the CPE WAN Management Protocol. Tkername is used only
for HTTP-based authentication of the CPE.

6. Password Password used to authenticate the CPE when makampnection to
the ACS using the CPE WAN Management Protocol. password is used only
for HTTP-based authentication of the CPE.

7. Periodic Inform Interval : An absolute time reference in UTC to determin@mh
the CPE will initiate the periodic Inform methodllsaEach Inform call MUST
occur at this reference time plus or minus an ettegultiple of the Periodic
Inform Interval.

8. Periodic Inform Enable: Whether or not the CPE MUST periodically send CPE
information to the ACS using the Inform method call

9. Connection Request UsernameJsername used to authenticate an ACS making
a Connection Request to the CPE.

10. Connection Request Password?assword used to authenticate an ACS making a
Connection Request to the CPE.

11. Click Apply.

3.4 Operation Mode

The Operation Mode page allows you to select tipeggpiate mode for your network.

Select your mode: wireless router, access pointedia bridge.

Operation Mode
Router >
TR-069 > Please Select Operation Mode
Operation Maode > @ Wireless Router
In Wireless Router mode. the router connects to the Internet via PPPoE, DHCP, PPTP, L2TP or Static IP and
Admin > shares the wireless network to LAN clients or devices. In this mode, NAT. firewall, and DHCP server are enabled
by default. UPnP and Dynamic DNS are supported for SOHO and home users. Select this mode if you are a first-
DFS Test Mode > time user or you are not currently using any wired/wireless routers
O Access Point
i >
Fast Roamlng In Access Point (AP) mode, your device connects to a Wireless Router through an Ethernet cable to extend the
5 wireless signal coverage to other network clients. In this mode, the firewall. IP sharing, and NAT functions are
Coverage disablad by default

O Media Bridge
Media Bridge mode provides a fast 802.11ac Wi-Fi connection for multiple media devices such as computer
Smart TV, game console, DVR, or media player simultaneously, via Ethernet cable. To set up the Media Bridge
made, you need two devices: one configured as a Media Bridge and the other as a router. In Media Bridge mode
only wireless devices connect to the AP Client devices need to be connected to the Media Bridge with a network
cable
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Steps to set operating mode:
1. From the navigation panel, gofRwot > Operation Mode
2. Select the mode that you want the router to run.

3. Click Apply.

3.4.1 Wireless Router Mode

In wireless router mode, the router connects tdrkernet via PPPoE, DHCP, PPTP,
L2TP or Static IP and shares the wireless networkAN clients or devices. In this
mode, NAT, firewall, and DHCP server are enableddbfault. UPnP and Dynamic
DNS are supported for SOHO and home users. Sélisatniode if you are a first-time
user or you are not currently using any wired/vassl routers. Select the wireless
router mode, and click Apply to jump to the wizaahe, then refer tb wizard setup

for normal user setup.

3.4.2 Access Point Mode

In Access Point (AP) mode, your device connects twireless router through an
Ethernet cable to extend the wireless signal cgeeta other network clients. In this

mode the firewall, IP sharing and NAT functions digabled by default.

Root Wizard

Internet Setup

1| Internet Setup

2 | Network Setup LAN IP Setting

3 | Config Overview Get LAN IP Automatically? @Yes ONo
|P Address
Subnet Mask

Default Gateway

Connect to DNS Server Automatic... ®Yes O No
DNS Server 1

DNS Server 2

Next
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Steps to set up Access Point mode:
1. Click Apply, go toWizard > Internet setup.

* |IP Address. The LAN IP address of wireless router. The defaalue is
192.168.1.1. In IP-based networks, data packetssan¢ to the network
devices' specific IP addresses.

e Subnet Mask The LAN subnet mask of wireless router. The diefaaiue is
255.255.255.0

* DNS Server 1 & DNS Server 2:Either indicates the IP address of DNS
server that the wireless router will contact.

e Click Next.

2. Assign the wireless network name (SSID) and seclety for 2.4GHz and 5

GHz wireless connections.

Root Wizard

Network Setup
1| Internet Setup

2 | Network Setup 2.4GHz

3 | Config Overview SSID MySpectrumWiFi000044-2G
Key AYWSHSYLXyj
oGHz
|:| Same as 2.4GHz
SSID MySpectrumWiFi000044-5G
Key 5jUDoCorsS8

Apply

 SSID: The network name or SSID is a uniqgue name thahtifles the
wireless network. Wi-Fi devices automatically detai networks within
range.

* Key: A security key is the password that is assigreddcure a wireless

network from unauthorized access. To access aegdaa@twork, the user will
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be asked to enter the security key.
*  When done, cliclidpply.

3. To display the new configuration information clidlply .

Root Wizard

Config Overview

1| Internet Setup

2 | Network Setup LAN IP Setting

3 | Config Overview Get LAN IP Automatically? Yes
IP Address
Subnet Mask

Default Gateway
Connect to DNS Server Automatic. .. Yes
DNS Server 1

DNS Server 2

2.4GHz

SSID MySpectrumWiFiD00044-2G
Key ASWSHSYLXyj

S5GHz

SSID MySpectrumWiFiD00044-5G
Key 5jUDoCorsSa

3.4.3 Media Bridge Mode

Media Bridge mode provides a fast 802.11ac Wi-mnaxtion for multiple media
devices such as computer, Smart TV, game conso\R,Dor media player
simultaneously, via Ethernet cable. To set up thedlilsl Bridge mode, you need two
devices: one configured as a Media Bridge and theras a router. In Media Bridge
mode, only wireless devices connect directly torthger/AP. Client devices need to

be connected to the Media Bridge with a networkecgBelecMedia Bridgemode.
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Root  Wizard

Internet Setup

1 | Internet Setup

2 | Network Setup Select the network and click [Connect].

5 | Confia Oven
onfl VErview
I 9 Wireless name MAC Channel Wireless Security Band Radio
FERA- ¥ mixed WPA/WPA2 PSK
_wifi-5G B4:EE:B4:ES:AE:64 108 (TKIP, CCMP) 5GHz all
Network Key. 123456789 Show Password K
hello-5g 54:A0:50:6D:12:84 157 WPA2 PSK (CCMP) 5GHz l|||
BBB-5G B4.EEB4.E9:AG35 116 WPA2 PSK (CCMP) 5GHz ul
AAA-GUEST-5G BAEE:B4E9AB.03 136 WPA2 PSK (CCMP) 5GHz ul

To set up Media Bridge mode:
1. Click Apply, go to Wizard > Internet setup.
* Select the wireless network to connect your medidgke to and enter the
password.
* When done, cliciConnect

2. Input LAN IP information and clicldpply .

Root Wizard

Internst Setup

1 | internet Setup

2 | Network Setup LAN IP Setting

3 | Config Overview Get LAN IP Automatically? @Yes OnNo
IP Address
Subnet Mask

Default Gateway
Connect to DNS Server Automatic... @ Yes O No
DNS Server 1

DNS Server 2

* |IP Address. The LAN IP address of wireless router. The defaalue is
192.168.1.1. In IP-based networks, data packetssan¢ to the network
devices' specific IP addresses.

e Subnet Mask The LAN subnet mask of wireless router. The diefaaiue is
255.255.255.0

* DNS Server 1& DNS Server 2:Either indicates the IP address of DNS
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server that the router will contact.

3. To display the new configuration information clidkply .

Root Wizard

1 | Internet Setup
2 | Network Setup

3 | Config Overview

Internet SetupConfig Overview

Basic

Frequency

SsSID

Authentic ation Method
WEP Encryption

Key Index

Network Key

WPA Encryption
WPA Pre-shared Key

LAN [P Setting

Get LAN IP Automatically?
IP Address
Subnet Mask

Default Gateway

Connect to DNS Server Automatic. ..

DNS Server 1
DNS Server 2
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3.5 Admin

3.5.1 System

Through this module, administrator can change admpassword, root’s login

password and operator’s password .

Root  Wizard
Admin > System
Router >
TR-069 > Change the Router Login Password
|
Operation Mode > Usemame e
Admin ¥ New Password
System Retype New Password [ ] show Password
Kinmwaie Username admin
DFS Test Mode > New Password
Fast Roaming > Retype New Password [I Show Password
Username operator
Coverage > B
New Password
Retype New Password D Show Password

Steps to change the router login password:

1. From the navigation panel, goRmot > Admin.

2. New Password Enter the new password you wish to use.

3. Retype New passwordRetype your new password for confirmation.
4

When done, cliclapply.
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3.5.2Firmware

This module enable administrator to upgrade firneatarough web.

Root Wizard

Admin > Firmware

Router >
TR-069 > Firmware
’ (O L
Operation Mode > Product ID 0000000000044
Admin v Hardware Version V1.0 REV:1
System Firmware Version 1.0.3
Firmware New Firmware File )

Steps to upgrade firmware:

1. From the navigation panel, gofwot > Admin > Firmware.

2. New Firmware File: Click “ to locate the firmware file.

3. Click Upload.
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3.6 DFS Test Mode

This module is used to test wireless switch.

Root  Wizard
DFS Test Mode
Router >
TR-069 > DFS Test Mode
‘

OperationMode > reg;yoce

Admin >

DFS Test Mode >
1. From the navigation panel, goRmot > DFS Test Mode.
2. Test Mode Enable or disable DFS test mode.
3.9 Fast Roaming
Set up fast roaming for smooth client roaming betw8SIDs.
Root  Wizard

Fast Roaming
Router >
TR-069 > Fast Roaming
:

Operation Mode > Freq 2.4GHz

Admin > Index 1

DFS Test Mode > Enable 11r Disable

Fast Roaming > Mobility Domain alb2

Coverage 5 AP BSSID (MAC) b4:ee:b4:e8:8f:.ce

AP2 BSSID (MAC) b4:ee:b4:e9:8f.cf
NAS Identifier foo

Steps to set up Fast Roaming:

1. From the navigation panel, goRmot > Fast Roaming.

2. Freq: Select 2.4GHz or 5GHz WiFi frequency to configure
3. Index: Select which index to configure.

4. Enable 11r. Enable or disable 11r (Fast Roaming).

5. Mobility Domain : Set 11r mobility domain.
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6. AP BSSID (MAC): Your/our AP’s MAC Address.
7. AP2 BSSID (MAC): Other AP’s MAC Address.
8. NAS Identifier: NAS ID of AP.
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3.10 Coverage

Coverage allows automatic network switching aceaydop the strength of the signal

(2.4GHz or 5GHz) to maintain optimum signal coruatiti

Root Wizard

Coverage
Router >
TR-069 > Basic Settings
Operation Mode > Band Steering Enable OYes @ No
Admin > SSID to Match
DFS Test Mode >
Fast Roaming > Station Database
Coverage > Include Out-of-Network Devices @ Yes O No

Mark Adv Client As Dual Band OYes @®No

Idle Steering Settings

Auth Allow OvYes @ No
5G RSSI steering (dB) 5

2.4G RSSl steering (dB) 20

Normal Inactive timer (s) 10

Overload Inactive timer (s) 10

Inactive Check Frequency (s) 1

Active Steering Settings

Client Tx over (Kbps) 50000
STA RSSI threshold (dB) 30
Client Tx under (Kbps) 6000
Client RSSI under (dB) 0

Steps to set up Coverage:
1. From the navigation panel, goRmot> Coverage.
2. Basic Settings:

* Band Steering Enable Enable or disable load balancing logic. Whole ldom
Coverage brings some new steering mechanisms godtaims in the Load
Balancing Daemon (Ibd) to handle more scenariosmaakie use of features
supported on newer Wi-Fi devices.

e SSID to match The SSID to match when limiting band steeringptdy a

129



single SSID.

Station Database:

Include Out-of-Network Devices Whether out of network devices should
be included in the database or not.
Mark Adv Client As Dual Band: Whether mark advertisement client as daul

band should be included in the database or not.

Idle Steering Settings:

5G RSSI steering (dB) RSSI value indicating a node associated on 5GHz
should be steered to 2.4GHz (dB).

2.4G RSSI steering (dB) RSSI value indicating a node associated on
2.4GHz should be steered to 5GHz (dB).

Active Steering Settings:

Client Tx over(Kbps): When the client Tx rate increases beyond this
threshold, generate an indication (Kbps).

STA RSSI threshold(dB) When evaluating a STA for rate-based upgrade
steering, the RSSI must also be above this thrdgd@).

Client Tx under(Kbps): When the client Tx rate decreases beyond this
threshold, generate an indication (Kbps).

Client RSSI under(dB). When the client RSSI decreases beyond this

threshold, generate an indication (dB).
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Offloading Settings

Interference Avoidance Steerin... ® Yes O No

Interference Avoidance Steerin... ® Yes O No
Use Best Effort OYes @No
Max Pollution Time (s) 1200

New report time avg (s) 60

2.4G overload limit % 70

5G overload limit % 70

2.4G active steering % 50

5G active steering % 60

Safe RSSI uplink (dB) 20

Offloading Settings:

* New report time avg (s) Time to average before generating a new
utilization report (S).

e 2.4G overload limit %: Medium utilization threshold for an overload
condition on 2.4GHz (%).

e 5G overload limit %: Medium utilization threshold for an overload
condition on 5GHz (%)

e 2.4G active steering % Medium utilization safety threshold for active
steering to 2.4GHz (%).

e b5G active steering % Medium utilization safety threshold for active
steering to 5GHz (%)

 Safe RSSI uplink (dB) Uplink RSSI (in dB) above which association will

be considered safe.

Steering Executor Settings:
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Steering Executor Settings

Legacy steering wait (s) 300

BTM steering wait (s) 30

* Legacy steering wait (s) Time to wait before steering a legacy client agai
after completing steering (Ss).
* BTM steering wait (s) Time to wait before steering a client via BTM aga

after completing steering without sending an aajaat (s).

Basic Advanced

Recent measurement (s) 5

Station Database Advanced

Size Threshold For Aging Timer 100
Aging Timer Frequency (s) 60
Out-of-network max (s) 300

Max Age for In-Network Client (s) | 2592000
Num Remote BSSes -

Populate Non Serving PHY Info 1

Post-association steering decision maker

2 4G RSSI measurements 5

5G RS5I| measurements 5

Utilization Monitor Advanced Settings

RSSI avg probe requests 1

2 4G check frequency (s) 10
5G check frequency (s) 10
MUReport Period (s) 30

Load Balancing Allowed Max P._. 15

Num Remote Channels 3

8. Basic Advanced:
* Recent measurement (s)Maximum number of seconds elapsed allowed for
a 'recent' measurement.

9. Station Database Advanced:
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e Qut-of-network max (s). Max Age for Out-of-Network Client (s).
10. Post-association steering decision maker:
e 2.4G RSSI measurementsNumber of RSSI measurements on 2.4GHz
band.
* 5G RSSI measurementsNumber of RSSI measurements on 5GHz band.
11. Utilization Monitor Advanced Settings:
* RSSI avg probe requestsNumber of probe requests required for the RSSI
averaging.
 2.4G check frequency(s) The frequency to check medium utilization on
2.4GHz .
e 5G check frequency(s) The frequency to check medium utilization on

5GHz.

133



12. Rate estimation:

Rate estimation

5G RSSI difference -15
2.4G RSSI difference 5
RSSI avg probe requests 3
Data rate estimate (s) 1
PHY scaling factor (%) 50
Continuous measure demo OvYes @®No
11k active scan (s) 50
11k passive scan (s) 200
11k Prohibit Time Short (s) 30
11k Prohibit Time Long (s) 300
Fast Pollution Detect Buf Size 10

Narmal Pollution Detect Buf Size 10

Pollution Detect Threshold 60
Pollution Clear Threshold 40
Interference Age Limit (s) 15
IAS Low RSSI Threshol (dB) 12
IAS Max Rate Factor 88
IAS Min Delta Bytes 2000
IAS Min Delta Packets 10

* 5G RSSI difference Difference when estimating 5GHz RSSI value frém t
one measured on 2.4GHz.

* 2.4G RSSI difference Difference when estimating 2.4GHz RSSI value from
the one measured on 5GHz.

* RSSI avg probe requestsNumber of probe requests required for the RSSI
averaging.

 Data rate estimate (s) Seconds between successive stats samples for
estimating data rate.

* PHY scaling factor (%): Scaling factor (as percentage) for converting PHY
rate to upper layer rate for airtime computations.

e Continuous measure demp Continuously measure throughput (for demo
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purposes only).
11k active scan (s)Active scan duration used in 802.11k Beacon Regsyr

11k passive scan (s)Passive scan duration used in 802.11k BeaconrRepo

request (s).
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13.

Steering Executor Advanced Settings

Abort steering time (s) 15
Coalesce reject time (s) 2

Max auth. rejects 3
Unfriendly time (s) 600
Max unfriendly STAs (s) 604800
2 4G RSSl assoc. (dB) 5

5G RSSl assoc. (dB) 15
Autoremove blacklist (s) 900
BTM response wait (s) 10
Association wait (s) 6

If setto 1, will also setup blackli... 1

BTM unfriendly (s) 600
Unfriendly BTM STAs (s) 86400
BTM STA backoff (s) 604800
Min best effort RSSI dB 12
RSSI indication (dB) 10
Start In BTM Active State OYes @ No
Delay 24G Probe RSSI Thresh. .. 35
Delay 24G Probe Time Window... | 0

Delay 24G Probe Min Req Count 0

Steering Executor Advanced Settings:

* Abort steering time (s} Maximum time for client to associate on targatda
before AP aborts steering (S).

* Coalesce reject time (s)Time to coalesce multiple authentication rejects
down to a single one (s).

* Max auth. Rejects Max consecutive authentication rejects after Whire
device is marked as steering unfriendly.

* Unfriendly time (s): The base amount of time a device is considersztisg
unfriendly before another attempt (s).

* Max unfriendly STAs (s): The maximum time used for backoff for steering

Total of backoff is caldeld as min

unfriendly STAs. amount

(MaxSteeringUnfriendly, SteeringUnfriendlyTime * 2 N

CountConsecutiveFailures) (S).
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2.4G RSSI assoc. (dBRSSI threshold indicating 2.4GHz band is notrggro
enough for association (dB).

5G RSSI assoc. (dB)RSSI threshold indicating 5GHz band is not strong
enough for association (dB).

Autoremove blacklist (s} The amount of time (in seconds) before
automatically removing the blacklist (s).

BTM response wait (s) The amount of time to wait for a BTM response (s)
Association wait (s) The amount of time to wait for an associationtoa
correct band after receiving a BTM response (S).

BTM unfriendly (s): The base amount of time a device is considered
BTM-steering unfriendly before another attempttees via BTM (s).
Unfriendly BTM STAs (s): The maximum time used for backoff for BTM
unfriendly STAs. Total amount of backoff is caldgld as min
(MaxBTMUnfriendly, BTMUnfriendlyTime * 2 ~ CountCasecutiveFailures)
(s).

BTM STA backoff (s): The maximum time used for backoff for BTM STAs
that fail active steering. Total amount of backddf calculated as min
(MaxBTMActiveUnfriendly, BTMUnfriendlyTime * 2 A
CountConsecutiveFailures) (s).

Min best effort RSSI dB: The minimum RSSI, below which Ibd will only
steer clients via best effort (no blacklists, feelsido not mark as unfriendly)
(dB).

RSSI indication (dB): RSSI threshold to generate an indication when a

client crosses it (dB).
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Steering Algorithm Advanced Settings

Downlink rate (Mbps) 53

Max Steering Target Count 1

AP Steering thresholds

Low RSSI APSteer Threshold ... 20
Low RSSI APSteer Threshold ... 45
APSteer To Root Min RSSI Inc... 5

APSteer To Leaf Min RSSI Inc... 10
APSteer To Peer Min RSSI Inc... 10
Downlink RSSI Threshold WS (.. -65

14. Steering Algorithm Advanced Settings
* Downlink rate (Mbps): Downlink rate (in Mbps) should exceed at leasivLo
TxRateXingThreshold + this value, when steeringnfrd.4GHz to 5GHz due

to overload.
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4.0 FCC Statement:

Federal Communication Commission Interference Stataent

This equipment has been tested and found to comily the limits for a Class B
digital device, pursuant to Part 15 of the FCC RulEhese limits are designed to
provide reasonable protection against harmful fatence in a residential installation.
This equipment generates, uses and can radiate fieejuency energy and, if not
installed and used in accordance with the instoasti may cause harmful interference
to radio communications. However, there is no guae that interference will not
occur in a particular installation. If this equipmeloes cause harmful interference to
radio or television reception, which can be deteediby turning the equipment off
and on, the user is encouraged to try to correetitherference by one of the

following measures:

@ Reorient or relocate the receiving antenna.
@ Increase the separation between the equipmenteard/er.

@ Connect the equipment into an outlet on a cirdifferent from that to which the
receiver is connected.

@ Consult the dealer or an experienced radio/TYiretan for help.

FCC Caution: Any changes or modifications not egpieapproved by the party

responsible for compliance could void the userthaiity to operate this equipment.

This device complies with Part 15 of the FCC Rul@peration is subject to the
following two conditions: (1) This device may nause harmful interference, and (2)
this device must accept any interference receivadluding interference that

may cause undesired operation.

For product available in the USA/Canada markety chbnnel 1~11 can be operated.
Selection of other channels is not possible.
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This device is restricted for indoor use.

IMPORTANT NOTE:

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation expostlinits set forth for an
uncontrolled environment. This equipment shouldimstalled and operated with

minimum distance 25 cm between the radiator & yumdy.
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